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Introduction 

Thank you for purchasing DMC product. 

This manual describes the operations of screen editor InfoSOSA Builder for InfoSOSA. 

Please read this manual carefully and use the product correctly. 

 

Target audience 

✓ For those setting up and operating InfoSOSA Builder. 

✓ For those interested in convenient InfoSOSA Builder uses. 

 

Target version 

This manual describes the following versions of InfoSOSA Builder. 

Some operations may differ depending on the version. 

Please refer to "InfoSOSA ReleaseNote" for details. 

 

InfoSOSA Builder 2.7.1 

 

Precautions for Safe Use 

Safety notations are written in this document for this product to be used safely. 

Please read this document along with other documents, and to fully understand the correct handling and 

functions of the InfoSOSA Builder. 

 

◼ Safety Symbol Legends 

Safety symbols as below are noted throughout this document for the InfoSOSA to be used correctly and 

safely: 

 

Caution 

Indicates a procedure, condition, or statement that should be noted 
in order for the equipment to be used correctly. 

 

Copyright and Trademarks 

◼ Please use this software in compliance with the "Software License". 

◼ Copyright of this manual is owned by DMC Corporation. 

◼ Reproduction and/or duplication of this product and/or this manual, in any form, in whole or in part, without 

permission is strictly prohibited. 

◼ This product and/or the contents in this document are subject to change without prior notice.  

◼ Although all efforts have been made to ensure the accuracy of this product and/or the contents in this 

document, should you notice errors, please feel free to contact and notify us. 

◼ DMC shall not be held liable for any damages or losses, nor be held responsible for any claims by a third 

party as a result of using this product.  

◼ Microsoft®, Windows®, Windows® 10, Windows® 11, and Microsoft® .NET Framework are trademarks or 

registered trademarks of Microsoft Corporation USA and other countries. 

◼ Other company and/or product names listed herein are also trademarks and/or registered trademarks. 

  



 

InfoSOSA Builder Operation Manual ii 

 

 

 

 

Handling of Image and Sound Files 

When using image and sound files, please use original files created by individual users. 

Using and distributing, without permission, files protected by copyright is strictly prohibited by law. 

Please note some free materials might have usage restrictions. 

 
 

About Notations 

The following describe information necessary in using this product. 

 

 

NOTE 

 Provides supplemental information on operations, descriptions, and settings. 

 

 

 

 

 

 

 

IMPORTANT 

Provides valuable information on operations, descriptions, and settings that require extra precaution. 
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Reference Documents 

InfoSOSA includes the following documents. Refer to the manual that meets your purpose. 

IS731 Series Startup Guide 

This is a manual for IS731 Series users. 

Provides explanations on the features of the InfoSOSA IS731 Series, functions unique to the InfoSOSA IS731 

Series, as well as a tutorial. 

 

Target audience 

✓ For those considering the IS731 Series 

✓ For those new to the IS731 Series 

✓ For those checking features of the IS731 Series 

 

 

IS-APP Startup Guide 

This is a manual for IS-APP users. 

This manual describes the features of the IS-APP, provides a tutorial, as well as explains functions and 

specifications unique to the IS-APP. 

 

Target audience 

✓ For those considering the IS-APP 

✓ For those new to the IS-APP 

✓ For those checking features and specifications of the IS-APP 

 

 

InfoSOSA Reference Manual 

This manual describes InfoSOSA functions and specifications. 

 

Target audience 

✓ For those checking details of InfoSOSA functions and specifications 

✓ For those checking communication specifications between InfoSOSA and microcontroller devices 
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InfoSOSA Builder Operation Manual (this manual) 

Refers to this document. 

This describes how to operate the InfoSOSA Builder. 

 

Target audience 

✓ For those setting up and operating InfoSOSA Builder. 

✓ For those interested in convenient InfoSOSA Builder uses. 

 

 

Host Communication Tester Manual 

This manual describes host communication operations. 

* Note: Host Communication Tester is a software to check the communication with the InfoSOSA with a PC instead of 

a microcontroller device. 

 

Target audience 

✓ For those testing communication with InfoSOSA without a microcontroller device. 

✓ For those debugging the microcontroller device and checking communication commands. 

✓ For those setting up and operating the host communication tester. 

 

 

InfoSOSA ReleaseNote 

Differences depending on the version of InfoSOSA are described. 

 

Target audience 

✓ For InfoSOSA users who are considering upgrading to a newer version. 
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1.1 InfoSOSA: Overview 

 

The InfoSOSA is a LCD touch panel display for microcontrollers. 

 

InfoSOSA and the microcontroller can be connected by using a single serial cable with no 

complicated wiring involved. 

 

Also, there is no complex screen processing to be done on the microcontroller since all 

processing will be done by InfoSOSA when displaying the screen. In addition, all screens 

displayed will be stored in the memory of InfoSOSA, so you will not have to prepare another 

memory for storing the screen on the microcontroller. 

 

By sending simple commands to InfoSOSA from the microcontroller, you will be able to operate 

the screens stored in the InfoSOSA and read/write memories. 

These operations can also be performed from the touchscreen of InfoSOSA. 

 

You can use the supplied drawing software InfoSOSA Builder to create the screens displayed on 

InfoSOSA. 
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1.2 About the InfoSOSA Application 

 

The InfoSOSA application is an application for displaying screen data created with the InfoSOSA 

Builder drawing software on DMC panel computers. 

 

By using InfoSOSA Builder, you can easily create an HMI even with a panel computer. 

 

Additionally, in cooperation with the user application running on the panel computer, you can 

expand on InfoSOSA standard functions to accomplish things you otherwise could not. 
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1.3 About InfoSOSA Builder 

 

InfoSOSA Builder is a screen editor for InfoSOSA. 

The following can be done with this software. 

Item Contents 

Create Screen Create screens to be displayed in the InfoSOSA 

Operation Check Check created screens and settings with the simulator 

Create Data, Download 
Download created screens and settings to the InfoSOSA unit. 
* The IS-APP only creates data. 

 

1.3.1 Features 

◼ Create colorful screens with rich features. 

The InfoSOSA is equipped with ample display functions such as buttons, switches, lamps, 

image displays, and strings. 

◼ Drag and drop to easily draw parts on the screen. 

You can create a screen by dragging and dropping from the toolbox whichever Parts you 

prefer supplied by the InfoSOSA Builder. 

◼ Your favorite image can easily be made into buttons. 

It is possible to make and use customized buttons on the screen by setting your favorite 

image. 

◼ Use data assets more flexibly. 

Project data that you create can be used on all InfoSOSA series. 

Note: If the resolution is different, adjustment of layout is required. 

Note: The features not supported by the destination model cannot be used. 

◼ Make various setting for Operation Setting (Action Setting).  

Preferred actions such as Host Communications or switching screens can be set by simply 

choosing the action. 

 

1.3.2 Development Flow 

Below is the main development procedure of the InfoSOSA Builder. 

Order Item Contents 

① Install Installing the InfoSOSA Builder 

② Creating and setting 
screens 

Create screen and make settings with the InfoSOSA Builder 

③ Screen simulation Check the operation of the screen that was created on a computer by 
using the InfoSOSA simulator 

④ Download Download screen to InfoSOSA 

⑤ Communication 
simulation 

Check the communication with Host Communication Tester by 
connecting the InfoSOSA and the computer. 

⑥ Confirmation Connect your equipment with InfoSOSA and check operations 
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1.4 About this document 
This document supports both the InfoSOSA IS731 series (hereafter referred to as IS series) and 

the InfoSOSA application (hereafter referred to as IS-APP) that runs on the EM series. 

 

While both IS series and IS-APP basically have the same functions, there are some IS series 

only functions and some IS-APP only functions. 

 

Supported functions for each series are identified with the following icons. 

 

 

 

Item for both IS series and IS-APP. 

 

 

Item for IS series. 

 

 

Item for IS-APP. 
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2.1 InfoSOSA Builder Operating Environment 

 

2.1.1 Operating Environment 

Item Contents 

OS Microsoft® Windows® 10 (64 Bit) 
or 
Microsoft® Windows® 11 (64 Bit) 

Framework/ 
Runtime 

Microsoft® .NET Framework 3.5 
Microsoft® .NET Framework 4.7 
Microsoft® Visual C++ 2015 Runtime 

Processor (equivalent) 1GHz or faster 

RAM 4GB or more 
(Recommended: 8GB or more) 

HDD 850MB or more free space (Recommended: 1GB or more) 

Display 1024×768 dots or more, True Color (32 bit) prefer 

USB Port For downloading project (screen data) 

Serial Port * For downloading project (screen data) 

* Communication error may occur according to the output signal level of the serial port (COM) of the 

computer you will be using. Please use the USB-serial conversion cable if this is the case. 

* Operation under virtual environment will be out of operating warranty. 

* Windows 11 compatibility applies to version 2.7.1 and later. 
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2.2 Install the InfoSOSA Builder 

 

 Caution 

Please make sure that there is enough free space (more than 850MB) in your computer’s hard 

disk before installing. 

 Caution 

Please install with Administrator privileges. 

 

 Caution 

Installation occurs for all users. 

 

 Caution 

In case of builder version upgrade, please uninstall the builder on PC in advance. 

 

2.2.1 Installation Procedure 

Start Installation 

 

1.  Please execute "software\builder\InfoSOSABuilder*.*.*.*.exe " in the download data.  

 

2.  A dialog for specifying the extraction destination is displayed. Click the [...] button, specify 

the extraction  

destination (desktop, etc.), and click the [Extract] button. 

 

 

 

3.  The "InfoSOSA Builder *. *. *. *" Folder is created in the extraction destination specified in 2. 

above. 

 

4.  Execute "Setup.exe" in the generated folder "InfoSOSABuilder *. *. *. *". 
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Install .NET Framework 

 

To run InfoSOSA Builder, Microsoft® .NET Framework 3.5 or .NET Framework 4.7 is required. 

If the PC you are using does not have it installed, when installing InfoSOSA Builder the .NET Framework 

installation dialog box will appear. 

When the InfoSOSA Builder installation screen is displayed, please follow the installation procedure.. 

 

.NET Framework 4.7 comes standard. If .NET Framework 3.5 is not installed, when the installer for the 

builder starts up a dialog box as shown below will appear. Select [Install this feature] to install .NET 

Framework 3.5. 

 

 

 

* As the .NET Framework installer uses Windows Update, an Internet connection is required. 
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Installation Procedure 

 

1.  When installing, you will see a dialog as below. 

    Click [Next]. 

  

 

2.  Check the license agreement, select the [I accept the terms in the License Agreement] check 

box and click [Next]. 
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3.  Specify the destination and click [Next]. 

  

4.  Click [Install]. 

  

5.  Installation will start. 
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6.  Installation is complete. 

 
 

After installation is complete, a shortcut  will appear on your desktop. 

 

 

Installation Microsoft Visual C++ 2015 Runtime 

If you get an error that "mfc140u.dll" is not found, follow the steps below to install "Microsoft 

Visual C++ 2015 Redistributable Package". 

 

1. Access Microsoft's download page. 

 

https://learn.microsoft.com/en-us/cpp/windows/latest-supported-vc-redist?view=msvc-170 

 

2. Download both "X86" and "X64" of Microsoft Visual C++ 2015 Runtime. 

 

X86 https://aka.ms/vs/17/release/vc_redist.x86.exe 

X64 https://aka.ms/vs/17/release/vc_redist.x64.exe 

 

3. Execute the downloaded "VC_redist.x64.exe" and "VC_redist.x86.exe" respectively to install. 

 

2.2.2 Uninstallation Procedure 

 

InfoSOSA Builder can be uninstalled from “Programs and Features” of “Control Panel”. 

https://learn.microsoft.com/en-us/cpp/windows/latest-supported-vc-redist?view=msvc-170
https://aka.ms/vs/17/release/vc_redist.x86.exe
https://aka.ms/vs/17/release/vc_redist.x64.exe
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2.3 Install USB device driver 

 

 

2.3.1 Installation Procedure 

To download project screen data with an USB cable, you need to install an USB device driver. 

 

First, connect the IS731 series unit and the PC with an USB cable, then turn on the IS731 series 

unit. 

 

■IS731-4WQ Series 

 

 

 

 

 

 

Then touch the “USB Mode” button. 

 

 

 

The following procedures vary depending on the version of the OS is used. 

  

USB Cable 
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1.  Right click on the start menu. 

  

 

 

2.  Click [Device Manager]. 
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3.  From [Other devices], right-click [InfoSOSA IS7] or [IS7 COMPOSITE COM]. 

 

 
 

4.  Click [Update Driver Software]. 
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5.  Click [Browse my computer for driver software]. 

 

 
 

6.  Click [Browse], and then specify the drive where the development kit data is inserted, 

or specify the folder where the device driver is saved. 
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7.  Select the [Include subfolders] check box and click [Next]. 

 

 

 

8.  If the screen below appears, click [Install]. 

 

 

 

9.  Installation is complete. 
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10.  Touch the Back button. 

 

 

 

11.  Turn off the power supply with the menu screen is displayed. 
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2.3.2 Uninstallation Procedure 

 

It can be uninstall from Device Manager. 

 

 

1．Connect the IS731 series unit and the PC with an USB cable, then turn on the IS731 series 

unit.  

 

 

 

 

 

 

 

 

2．Then touch the “USB Mode” button. 

 

 

 

  

USB Cable 
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3．Open the “Device Manager”. 

 

*For details on opening the device manager, refer to the installation procedure. 

 

4．From [Ports (COM and LPT)], right-click [InfoSOSA IS7 USB Port (COM*)]. 

 

* If there is more than one [InfoSOSA IS7 USB Port (COM *)], delete devices one by one 

 according to the procedure of 4. to 6. 

 

 

 

5．Click [Uninstall Device] or [Delete]. 

 

6．Check to [Delete the driver software for this device.] and click Uninstall. 

 

 
  



2. Install InfoSOSA Builder  

 

InfoSOSA Builder Operation Manual 21 

 

7．Touch the Back button with all [InfoSOSA IS7 USB Port (COM *)] uninstalled. 

 

 

 

 

8．From the [Port (COM and LPT)] another [InfoSOSA IS7 USB Port (COM*)] will be displayed, 

right-click [InfoSOSA IS7 USB Port (COM*)]. 

 

 

9．Click [Uninstall Device] or [Delete] to uninstall.  

 

 

Uninstallation is completed. 
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3. Screen Configuration of 
InfoSOSA Builder 

 

 

 

Chapter Contents 

3.1  Screen Configuration of InfoSOSA Builder .................................................. 23 

3.2  Details of Each Screen ................................................................................ 24 
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3.1 Screen Configuration of InfoSOSA Builder 

 

InfoSOSA Builder is composed of the following screens. 

 

 

No Item Contents 

①  Menu Bar Menu is displayed. 
Various operation settings as save and create files can be done. 

②  Tool Bar Available tools are displayed. 
Tools displayed in lighter color indicate that it cannot be used. 

③  Toolbox Parts that can be used for creating a screen are categorized. 

Drag and drop to place parts onto the screen editor. 

④  Drawing area Area mainly for creating screens, consisting of multiple tabs. 

⑤  Screen List Names of screens being created are displayed. 

Screens being created can be deleted or set. 

⑥  Property Area Properties of Parts selected in the screen editor are displayed. 

Use to quickly define some of the part settings such as layout, size, and 
color. * Use Advanced Properties Dialog in order to edit all the 
properties. 

 

 

② 

① 

③ 

④ 

⑤ 

⑥ 
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3.2 Details of Each Screen 

 

3.2.1 Menu Bar 

Menu bar consists of eight items. 

 

 
 
 

No Item Contents 

①  File Create new projects, save projects, and so on. 

②  Project Manage screens (Base Screen and Pop-up Screen). 

③  Edit Copy and delete parts, and so on. 

④  Display Change the display grid, and so on. 

⑤  System Settings Change system setting of InfoSOSA unit, including communication 
setting, and so on. 

⑥  Download Transfer project data to InfoSOSA unit. 
We can also create data for IS-APP. 

⑦  Simulation Simulate on computer without transferring to InfoSOSA unit. 

⑧  Help Check Version of InfoSOSA Builder. 

 

3.2.2 Tool Bar 

Functions used frequently are displayed as icons. 

 

 

Item Contents 

Create New Project 

Create a New Project. 

➢ 4.2 Create a New Project 

Open 

Open existing project file. 
➢ 4.3 Open an Existing Project 

 Save 
Save active project. 
➢ 4.4.1 Save 

Create New Screen 

Create new screen (Base Screen, Pop-up Screen). 

➢ 5.2.1 Add a Screen (Blank Screen) 

 Delete Selected Screen 
Deletes the selected screen. 
➢ 5.2.5 Delete Screen 

 Edit Selected Screen 
Edits the ID, title, and so on of the selected screen. 
➢ 5.2.3 Screen Settings 

 Cut 
Cut selected Parts on the screen. 
➢ 5.3.21 Cut Parts 

 Copy 
Copy selected Parts on the screen. 
➢ 5.3.22 Copy Parts 

Paste 
Paste onto the screen parts that were either cut or copied. 
➢ 5.3.23 Paste Parts 

①   ②   ③    ④     ⑤      ⑥      ⑦    ⑧ 
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Item Contents 

Undo 
Return to the previous state before the Parts changed. 

➢ 5.3.25 Undo 

Redo 

Return to the same state before the undo operation. 
➢ 5.3.26 Redo 

 Show Grid 
Displays grid in drawing area. 
➢ 6.2.1 Show Grid 

Align Grid 
Parts are placed to align with the grid. 
➢ 6.2.2 Snap to Grid 

 Grid Width 
Change display dot width of grid. 
➢ 6.2.3 Change Display Dot Width of Grid 

Show parts area 
Display dotted line of frame to Parts placed in drawing area. 
➢ 6.3 Display of Parts Area 

 Show Touch Panel Button 
Shows/hides the touch panel buttons. 
You can hide it when checking/editing the parts placed under 
the touch panel button. 
➢ 6.5 Display of Touch Panel Button 

 
String Resource Set 

Change string resource setting. 
➢ 8.1.3 String Resource Set Management 

 

3.2.3 Toolbox 
Parts that can be used for creating a screen are categorized. 

Drag and drop to place parts onto the screen editor. 

Parts that you can use vary depending on the selected model. 

For more information, please refer to 5.3.1 Select Part. 

 

  
  

① 

② 
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No Item Contents 

①  Pointer Cancel Parts placement mode, move, change size of Parts in drawing 
area, call property and action settings. 

②  Parts Various Parts can be use in InfoSOSA and some Parts have various 
functions. For example, generating events, displaying characters and 
numeric values, and so on. By combining layouts and actions, users are 
able to create screens that they prefer. 

 

3.2.4 Drawing area 

The drawing area consists of multiple tabs. 

Click each tab to switch tabs. 

The displayed tabs vary depending on the selected model. 

 

 

 

 

No Item Contents 

①  Screen Editor Screen where you can place parts to create screens that display on 

InfoSOSA. 

When screen editor is selected, [Screen Memory setting] is also 

displayed. 

②  Image Resource Image data management tab. Registering, deleting and editing is 
available. 

③  String Resources String management tab. Registering, deleting and editing is available. 

④  Global Memory Global Memory management tab. Registering, deleting and editing is 
available. 

⑤  Sheet Key Setting Sheet key switch and LED setting management tab 

⑥  Suboutine Screen for registering, deleting and editing subroutines. 

⑦  Sound Resources Sound data management tab. Registering, deleting and editing is 
available. 

 

⑤ ④ ⑥ ③ ① ② 

⑦ 
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3.2.5 Screen List 

Screen list is composed of Base Screen tab and Pop-up Screen tab. 

When you select a screen ID that is displayed in the list, it will be displayed on the screen editor. 

 

 

3.2.6 Property Area 

Displays properties of parts in the screen editor. 

* Use Advanced Properties Dialog in order to edit all the properties. 

 

 

 
 

No Item Contents 

①  Parts list Click to display Parts list. 

②  Property button Click to open Advanced Properties Dialog of selected Parts. 

③  Property display area Click to display property of selected Parts. 

 

① 

② 

③ 
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4. Start and Exit 
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◆The association of ipp files is done automatically during installation. 

4.1 Start Up InfoSOSA Builder 

 

4.1.1 Start from Desktop 

Double click the icon  on the desktop to start up the InfoSOSA Builder. 

 

4.1.2 Start from Start Menu 

Select from the Windows Start menu [Seedsware] - [InfoSOSABuilder*.*]. 

InfoSOSA Builder starts up. (*. * denotes the version number) 

 

4.1.3 How to boot from an ipp file 

By associating the ipp file with the InfoSOSA builder, you can open the ipp file from Explorer by 

double-clicking on it, and the InfoSOSA builder will start. *Ver. 2.7 or later 
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◆ You can open two projects and copy each resource between the 

projects. For details, please refer to Chapter 16. Inter-Project Copy. 

 

4.1.4 Multiple invocations of the InfoSOSA Builder 

When the InfoSOS builder is running and you start it again, the second InfoSOSA builder will 

start. (Max. 2) *Ver. 2.7 or later 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

◆ When running two versions of the InfoSOSA Builder, be sure to 

run the same version of the InfoSOSA Builder as the first one. This 
may cause problems with normal operation. 
 

◆ You cannot open the same project in two InfoSOSA Builders. 

 

◆ Simulators cannot be run simultaneously. 
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4.2 Create a New Project 

 

 

Create a new project. 

Procedure 

1.  From the [File] menu, select [Create New Project]. 

 

You can also run by using the [Ctrl]+[Shift]+[P] keyboard combination or clicking the  

icon  in the toolbar. 

 

2.  Select the Product Model that corresponds to your product. 

Selecting Series, Model, No of Colors, and Multilingual will display supported models. 
Choose the [Product Model] that corresponds to your product. 
Please refer to 17.1 Corresponding Model List for the corresponding product model and 

model name. 

 

Choose corresponding 
product model 
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3.  Enter the project name you wish to create in [Project Name] and specify a destination. 

Click [OK] and a project is created. 

 

* The storage location displayed is the location where you saved the previous project.  

Right after installation, the folder is in the users "Documents\Seedsware\Project" folder. 

 

4.  Base screen is displayed in the screen editor. 

 

You can create screens by placing Parts onto base screens. 

 

 

 

 

  

  

Base Screen 

Enter 

Destination to save 
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◆ After creating the project, you can change the [Default Screen 

Size] from the [H/W Settings Dialog]. 

 

 

 

As you can change its window size, IS-APP does not have a specific resolution on the 

builder. Therefore, you may want to set a standard screen size. This is called the [Default 

Screen Size]. 

 

Set up the [Default Screen Size] when you create the project. 

If you select the model name according to the product you are using, the default screen size 

will be set according to the product. 

For the correspondence between product models and model names, refer to “17.1 

Corresponding Model List”. 
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4.3 Open an Existing Project 

 

 

Select and open an existing project file. 

Procedure 

1.  From the [File] menu, select [Open]. 

 

You can also open by using the [Ctrl]+[O] keyboard combination or clicking the icon  

in the toolbar. 

 
2.  Select the name of the project you want to view, and click [Open]. 

 

* Displays the previously used location.  

Right after installation, the folder is in the users "Documents\Seedsware\Project" folder. 
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◆ In Ver. 2.7 or later, when you open a project file (.ipp) by 

double-clicking on it from Explorer, etc., the builder will start and you 
can open the project file directly. 

 

You can open a project that was created with InfoSOSA Builder Ver 2.1 with InfoSOSA 

Builder Ver 2.5/Ver 2.6.  

Version Support 

InfoSOSA Ver2.1 ○ 

InfoSOSA Ver2.5/2.6 ○ 

 

* A project saved in InfoSOSA Builder Ver 2.5/Ver 2.6 cannot be used in Ver 2.1. 

* If you open a Ver 2.1 project, it will be automatically backed up in the following file name 

in the same folder. 

<Project name>.bak_<Project Version>.ipp. 

For example, if you open a project named "test.ipp" created with version 2.1.2.198, it is 

backed up to the same folder with the following file name. 

test.bak_2.1.2.198.ipp 

 
3.  The selected project is displayed in the drawing area of the screen editor. 
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4.4 Save a Project 

 

4.4.1 Save 

Save the project currently being created. 

Procedure 

1.  From the [File] menu, select [Save]. 

 

You can also save by using the [Ctrl]+[S] keyboard combination or clicking the icon  in the 

toolbar. 

 

2.  "Project saved" is displayed. 
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4.4.2 Save As 

Save the project currently being created to a specified project name. 

Procedure 

1.  From the [File] menu, click [Save as]. 

 

 

2.  Select the save location, enter the file name, and click [Save]. 

 

* Displays the previously used location.  

Right after installation, the folder is in the users "Documents\Seedsware\Project" folder. 

 

3.  "Project saved" is displayed. 
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4.5 Close Project 

 

Close the open project. 

Procedure 

1.  From the [File] menu, select [Close]. 

 

 

2.  Click [Yes] to save the project, or click [No] to close without saving. 

  

* Click [Cancel] if you do not want to exit InfoSOSA Builder. 

 

3.  Project will close. 
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4.6 Open a Recent Project 

 

Exit InfoSOSA Builder. 

4.6.1 Project used last time 

The last used project can be opened by selecting “Yes” for the message displayed at startup. 

* The path of the target project is displayed from Ver2.7.1.5 onwards. 

 

 

 

 

4.6.2 Recent projects 

Recent projects can be opened from the following method. 

 

Method 

1.  From the [File] menu, click [Exit]. 
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4.7 Exit InfoSOSA Builder 

 

Exit InfoSOSA Builder. 

Procedure 

1.  From the [File] menu, click [Exit]. 

 

 

You can also exit by clicking the top-right corner of the InfoSOSA Builder window  

 

2.  Click [Yes] to save the project, or click [No] to close without saving. 

 

* Click [Cancel] if you do not want to exit InfoSOSA Builder. 

 

3.  InfoSOSA Builder will shut down. 
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4.8 Version Information 

 

Check the version of InfoSOSA Builder. 

Procedure 

1.  From the [Help] menu, click [Version Information]. 

 

 

2.  "InfoSOSA Builder Version Information" is displayed. 

 

The InfoSOSA Builder Version is displayed in the [Builder Program] property. 

(The other values are internal component version numbers.) 

 

* Version number depends on the InfoSOSA Builder installed. 
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5. Create a Screen 

 

 

 

Chapter Contents 
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5.5  Change Color of Parts ................................................................................. 89 
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5.8  Property Setting of Parts ............................................................................. 95 
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5.1 Create a Screen 

 

Select the [Screen Editor] tab in the drawing area to create InfoSOSA screens and place Parts 

onto the Base Screen (Pop-up Screen). 

* For more information about each part, please refer to the "Reference Manual". 

 

 

 
 
 
 
 

  

Select [Screen Editor] tab 
Displays the base screen (pop-up screen) 
you are drawing. 

Base Screen (Pop-up screen) 
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5.2 Screen Settings 

 

This section describes the settings and creating of the Base Screen or Pop-up Screen. 

5.2.1 Add a Screen (Blank Screen) 

Create and add a new blank screen. 

Select [Base Screen], [Pop-up Screen A] or [Pop-up Screen B] at the time of creation. 

Procedure 

1.  From the [File] menu, select [Create New Screen]. 

 

You can also create by using the keyboard combination [Ctrl]+[Shift]+[B] or clicking the icon 

 in the toolbar. 

 

2.  The [Create New Screen] dialog box is displayed. Select the [Create New Screen] option. 

Edit the [Screen Title], and from the [Type of Screen] list select the screen you want to create. 

After setup, click [Add]. 
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3.  Blank screen is created and added to the screen list area. 

 

 

 

 

The size of the empty screen is the same resolution as the selected model. 

 

 

The size of the empty screen is the same as the [Default screen size] setting. 
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5.2.2 Add a Screen (Create by Copying) 

Create a screen by copying an existing screen. 

Procedure 

1.  From the [File] menu, select [Create New Screen]. 

 

You can also use the [Ctrl]+[Shift]+[B] keyboard combination or click the icon  in the 

toolbar. 

 

2.  From the [Create New Screen] dialog box, select the [Copy and create new screen] option. 

Select the source screen.  

Edit the [Screen Title] and click [Add]. 

* Screen type is same as source of the screen to be copied. 

   

  

Select the source 

screen to be copied 
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3.  Copied screen is created and added to the screen list area. 

 

5.2.3 Screen Settings 

Edit ID and title, etc. of screen. 

Procedure 

1.  On the screen editor, click [Screen Settings]. 
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2.  [Screen Settings Dialog] is displayed. 

Edit each item and click [OK]. 

 

No Item Contents 

① Screen ID ID for identifying the screen. 
ID is used for action settings and screen selection. 
You cannot set the same screen ID or parts ID as one that is already used. 

② Screen Title Set title of screen. 
You can enter up to 256 single-byte or double-byte characters. Both single and 
double-byte characters are counted as one character. 

③ Screen Type Type of screen is displayed. 
The screen types are: Base Screen, Pop-up Screen A, and Pop-up Screen B. 
Change cannot be made after it is created. 

 

  

① 

② 

③ 
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5.2.4 Select Screens 

Select screen to display on Screen Editor. 

Procedure 

1.  Select the base screen to display from the screen list. 

Base Screen that has been selected will be displayed on the Screen Editor. 

 

 

If you want to display a pop-up screen, choose from screen list in the [Pop-up Screen] tab. 

 

  



5. Create a Screen  

InfoSOSA Builder Operation Manual 50 

 

5.2.5 Delete Screens 

Delete the registered screen. 

Procedure 

1.  Select the screen to delete from the screen list. 

On the screen editor, click [Delete]. 

 

Or select the screen to delete from the screen list, and from the right-click menu click 

[Delete]. 

 

  

Select the screen to delete 
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2.  After a confirmation message is displayed, click [OK]. 

 

 

3.  Screen will be deleted. 

 

5.2.6 Error check Screens 

Check for errors in the currently selected screen. 

 

Procedure 

1.  Select the screen you want to check for errors from the screen list. 

 

2.  Click "Error check" from the right-click menu. 

 

 

 

Check for errors on the target screen only. 

 

If you want to check all the screens for errors, please execute "Error check" in the top menu 

"Download". 
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5.3 Arrange and Move Parts 

 

This section describes how to arrange and move Parts. 

5.3.1 Select Parts 

Parts used to create screens are stored under each category in the Toolbox. 

* For more information about each part, please refer to the "Reference Manual". 

Displaying Parts 

Selecting Category 

Click a category and the Parts are displayed. 

                           

  

Click the category of 
the part you want to 
display 

 

The clicked 
category parts are 
displayed 
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Scroll Display 

Scroll with the cursor on the side for Parts that cannot be displayed all at once. 

                          

  

Scroll up 

Scroll down 

Display by scroll 
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5.3.2 Parts Placement 

Place the parts on the screen. 

It is possible to temporarily move it outside the drawing area, but please place it within the 

drawing area before execution. 

 

 

 

 

 

 

  

 
 
 

Drawing area 

 
 
 
 
 
 
 
 
 
Temporary evacuation area 
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Procedure 1 Parts Placement by Toolbox 

1.  Click on the category of the Parts to be placed from the Toolbox. 

 

 

 

  

When you click a category, all 

its parts are displayed. 
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2.  Click on the Parts to be placed from the Toolbox, and the Parts will become active. 

Parts that were selected will be placed when you click on the screen. 

It can also be placed by drag-and-drop. 

 

The active state of Parts selected will not be released even after the Parts are placed. 

When you click on an area where Parts are not placed, it will allow you to repeat placing 

Parts. 

To release the active state of the Parts, click [Pointer] in the Toolbox area, or right-click on 

the screen. 

 

 

 

  

Place by Drag-and-Drop or 
click. 

Pointer 
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Procedure 2 Part Placement by Drag-and-Drop 

1. From the Web browser or from Explore, drag-and-drop onto the drawing area the image 

that you want to register. Or paste (Ctrl+V) from the clipboard into the drawing area. 

 

 

   

 

 

  

 

* There are cases when pasting image by drag-and-drop is limited by the security function 

of the Web browser. For how to cancel the security features, please refer to the Web 

browser manual. 

 

Web browser Desktop 
Explorer 

 

Word, Excel documents, etc. 

Drag-and-Drop to place  Place by paste (Ctrl+V) 
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2.  Select the Parts type, and then click [OK]. 

 

 
3.  The selected Parts will be placed. 
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5.3.3 Move Parts (Mouse, Keyboard) 

Move the Parts by using a mouse or keyboard. 

Procedure 

1.  Select the Parts on the screen. 

 

 

2.  Drag-and-drop to move parts. 

You can also move the Parts with the cursor keys on the keyboard. 
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5.3.4 Move Parts (Position Specified) 

Move the position of the Parts to the specified coordinates. 

Procedure 

1.  Select the Parts to be moved 

 

 

2.  In the property area's [Layout], enter the coordinates in the [H.Pos.] and [V.Pos.] fields. 

The upper left corner of the drawing area is the origin point (0,0). 

The upper left corner of the Parts is the origin point for its coordinates. 

 

* You can also input from the [Advanced Properties Dialog]. 

 

3.  Parts will move to the input position. 

 

    

(200,50) 

(0,0) 
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5.3.5 Change Size of Parts (Mouse) 

Change size of the Parts by using mouse. 

Procedure 

1.  Select the Parts to scale. 

 

 
2.  Move the cursor to the corners of the Parts. 

   

 
3.  Drag while holding down the left mouse button and change the size of the Parts. 

 

 
 
 
 
  

Width, Height 

Width 

Height 
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5.3.6 Change Size of Parts (Specify Size) 

Specify the size and change the size of the Parts. 

Procedure 

1.  Select the Parts to resize. 

 

 

2.  In the property area's [Layout], enter values in the [Width] and [Height] fields. 

When scaling Parts, it will be scaled with the upper-left corner of the Part as a reference. 

Check the coordinates of the Parts and set so the Parts will fit within the display screen after 

enlargement. 

 

* You can also input from the [Advanced Properties Dialog]. 

 

3.  The size of the Parts will change. 

 
  

Height 

Width 

Scaled from 
the upper-left 
corner 

The height of the Parts will change 
according to the numerical value. 

The width of the Parts will change 
according to the numerical value. 
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5.3.7 Batch Select Multiple Parts 

Select by batch multiple Parts that are arranged on the screen editor. 

After selecting, you can make batch adjustments. 

In order to make batch adjustments, you will need to set a standard Part. 

Reference Part 

Parts that are reference parts display blue points when selected. 

Reference part    Not a reference part  

(blue indicates selected)                        (white indicates selected) 

       

 

How to Select Multiple Parts 

Selecting all Parts on screen 

1.  From the [Edit] menu, click [Select All]. 

You can also use the [Ctrl]+[A] keyboard combination. 

 

 

2.  All of the Parts on the screen will be in the selected state. 

 

  

The first part that is placed 
is the reference part. 
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Select by dragging 

Select by dragging the mouse. 

Parts inside the dragging area become selected. 

 

 

Select using the [Ctrl] key 

Continue to click on the Parts in order while holding down the [Ctrl] key. 

Clicked Parts become selected. 

  

 

  

The first part that is placed 
is the reference part. 

 

③ 

② 

① 

Drag the mouse 

The last selected part is 
the reference part. 
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5.3.8 Batch Adjust Multiple Parts (Vertical Position) 

Align the vertical positions of the multiple Parts placed on the screen to the referenced. 

Procedure 

1.  Select the Parts to adjust, then right-click on the Parts. 

 

2.  From the menu, select [Align/Match] - [Align Top] or [Align Bottom]. 

 

3.  Parts that were selected to match the top or bottom of the reference Part will be aligned. 

 

  

This Part is the reference. 
Reference line when aligned top 

Reference line when aligned bottom 
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5.3.9 Batch Adjust Multiple Parts (Horizontal Position) 

Align the horizontal positions of the multiple Parts placed on the screen to the reference Part. 

Procedure 

1.  Select the Parts to adjust, then right-click on the Parts. 

 

2.  From the menu, select [Align/Match] - [Align Left] or [Align Right]. 

 

3.  Parts that were selected will align to the left or the right of the selected reference Part. 

 

This Part is the reference. 

Reference line when aligned right Reference line when aligned left 
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5.3.10 Batch Adjust Multiple Parts (Horizontal Width) 

Align the horizontal width of the multiple Parts placed on the screen to the reference Part. 

Procedure 

1.  Select the Parts to adjust, then right-click on the Parts. 

 

2.  From the menu, select [Align/Match] - [Match Width]. 

 

3.  Parts selected will become the same width with the reference Part. 

  

This Part is the reference. 
It will be the same width 
as this Part. 
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5.3.11 Batch Adjust Multiple Parts (Height) 

Align the height of the multiple Parts placed on the screen to the reference Part. 

Procedure 

1.  Select the Parts to adjust, then right-click on the Parts.  

 

2.  From the menu, select [Align/Match] - [Match Height]. 

 

3.  Parts that were selected will become the same height with the reference Part. 

 

  

This Part is the reference. 
It will be the same height 
as this Part. 
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5.3.12 Batch Adjust Multiple Parts (Properties) 

Change the property of the multiple Parts placed on the screen. 

* There are properties that cannot be changed in a batch. 

* Only common properties of multiple types of Parts can be changed at once. 

Procedure 

1.  Select the Parts to edit, and in the Property area change the settings of common properties. 

 

 

 

2.  Properties of the selected Parts will be changed at once. 
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5.3.13 Change Parts Order (Bring to Front) 

Bring the selected Part to the forefront of overlapping Parts. 

Procedure 

1.  Select the Part to be displayed in the front, right-click on the Part. 

 

2.  From the menu, select [Z-Order] - [Bring to Front]. 

 

3.  The selected Part will be displayed in the forefront. 
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5.3.14 Change Parts Order (Send to Back) 

Bring selected Part to backmost of the overlapping Parts. 

Procedure 

1.  Select the Part to be displayed at the backmost, right-click on the Part. 

 

2.  From the menu, select [Z-Order] - [Send to Back]. 

 

3.  The selected Part will be displayed at the backmost. 
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5.3.15 Change Parts Order (Bring Forward) 

Display of the selected Parts will move one layer forward. 

Procedure 

1.  Select the Part to move to the front, right-click on the Part.  

 

2.  From the menu, select [Z-Order] - [Bring Forward].  

 

3.  The selected Part will be displayed on top of the Part that was directly on top of it. 
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5.3.16 Change Parts Order (Send Backward) 

Display of the selected Parts will move one layer backward. 

Procedure 

1.  Select the Part to move to the back, right-click on the Part. 

 

2.  From the menu, select [Z-Order] - [Send Backward]. 

    

3.  The selected Part will be displayed behind the Part that was directly under it. 
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5.3.17 Group Parts 

Group multiple Parts placed in the screen. 

Procedure 

1.  Select the Parts to be grouped, right-click on the Parts. 

 

2.  From the menu, select [Group] - [Group]. 

 

3.  The selected Parts will be grouped. 
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5.3.18 Move Group (Mouse, Keyboard) 

Move the grouped Parts. 

Procedure 

1.  Select the group on the screen. 

 

 

2.  Drag-and-drop to move parts. 

You can also move the Parts with the cursor keys on the keyboard. 
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5.3.19 Change Size of Group (Mouse) 

Change the size of a group using the mouse. 

* Size of all Parts in the group will be enlarged or reduced. 

Procedure 

1.  Select the group to scale. 

 

 
2.  Position the cursor in the corner of the group. 

 

 
3.  Drag while holding down the left mouse button, and then scale the group. 

 

 

 

 

  

Width, Height 

Width 

Height 
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5.3.20 Property Setting of the Grouped Parts 

Change the property of the grouped Parts. 

Procedure 

1.  Select the group. 

 

 

2.  Select the Part in the selected group and right-click. From the menu, select [Advanced 
Properties]. 

  

Or double-click the Part. 

 
3.  [Advanced Properties Dialog] is displayed. 

 

 

  



5. Create a Screen  

InfoSOSA Builder Operation Manual 78 

5.3.21 Cut Parts 

Cut selected Parts on the screen. 

You can use [Paste] to paste the Parts that were cut on the screen. 

You can also cut grouped Parts. 

Procedure 

1.  Select the Parts to cut and right-click. 

From the menu, select [Cut]. 

  

You can also cut by selecting [Cut] from the [Edit] menu, [Ctrl]+[X] keyboard combination, or 

by clicking the scissors icon  in the toolbar. 

 

2.  Parts will be cut to the clipboard. 
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5.3.22 Copy Parts 

Copy selected Parts on the screen. 

You can use [Paste] to paste the Parts that were copied on the screen. 

Procedure 

1.  Select the Parts to copy and right-click. 

From the menu, select [Copy].  

 

You can also copy by selecting [Copy] from the [Edit] menu, [Ctrl]+[C] keyboard combination, 

or by clicking the copy icon  in the toolbar. 

 

2.  Parts will be copied to the clipboard. 
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5.3.23 Paste Parts 

Paste Parts onto the screen that were either cut or copied. 

It is also possible to copy the image to the clipboard by Explorer and/or paint software and paste 

it as a Part. 

* You may not be able to be paste it according to the format of image files or size. 

Procedure 

1.  Select the screen to place the Parts and right-click. 

From the menu, select [Paste].  

 

You can use [Paste] from the [Edit] menu, [Ctrl]+[V] keyboard combination, or by clicking the 

paste icon  in the toolbar. 

 

2.  The Part that was cut or copied is pasted on the screen. 

 

When pasting images, the following dialog box appears. Set the [Parts Type], position and 

size. 

* Other properties can be edited after placement. 
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5.3.24 Delete Parts 

Delete the selected Parts on the screen. 

You can also delete a selected group on the screen. 

Procedure 

Select the Parts to delete and right-click. 

From the menu, select [Delete]. 

 

You can also delete by selecting [Delete] from the [Edit] menu or the [Delete] key. 
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5.3.25 Undo 

Undo the change of the Part properties that have been made. 

Undo can be done up to 20 times. 

 

Caution 

Only screen editor tab is subject to change. 

Other tabs will be excluded. 

 

 

Procedure 

From the [Edit] menu, select [Undo]. 

You can also undo by using the [Ctrl]+[Z] keyboard combination or the undo icon  in the 

toolbar. 
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5.3.26 Redo 

Return to the same state before the undo operation. 

 

Procedure 

From the [Edit] menu, select [Redo]. 

You can also redo by using the [Ctrl]+[Y] keyboard combination or the redo icon  in the 

toolbar. 
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5.4 Display Characters 

 

This section describes displaying of characters of the Parts. 

5.4.1 Select System Font 

Change the font when using and displaying the system font, or when changing to language other 

than Japanese. All characters (system font) of the Parts will have the common setting. 

Set from the [System Font Settings] dialog box. 

Procedure 

1.  From the [System Settings] menu, select [System Font Settings]. 

 

 

2.  The [System Font Settings] dialog box appears. 

  

* Available types and number of fonts vary according to the model. 
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3.  Place a check of the system font you want to use, and click [OK]. 

 

[Japanese Gothic (BOLD)] 

 

 

[Japanese Gothic (NORMAL)] 

 

 

For more information, please refer to 13.4 System Font Settings. 

 

 

5.4.2 Display Text 

Display text on Parts. 

Display by directly inputting strings to the property area. 

You can also display by linking the string type memory and/or string resources. 

If you want to use the image fonts, please do so from the [Advanced] dialog box. 

Procedure 

1.  Select the part that will display the text. 

 

 
2.  From the [Property] area, edit the properties in the [String] category. 

 

* You can also set from the parts [Advanced Properties] dialog box. 

 
 
 
 
 

① 

④ 

③ 

② 
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No Item Contents 

① String Enter string to be displayed. 

② H.Position Select horizontal position of character. 

③ V.Position Select vertical position of character. 

④ Size Select character size. 

 
3.  Text is displayed on the button. 

 

 

5.4.3 Use Image Fonts 

Variety of fonts can be displayed when using image fonts. 

 

Procedure 

1.  Select [Advanced Properties] from the right-click menu of the Part to change the font. 

 

2.  [Advanced Properties Dialog] is displayed. 
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3.  Change the [Font Type] to [Image Font]. 

 

 

4.  Select the font to use. 

 

 

* Font installed on your computer is displayed. 

 

Note 

・ When using the image fonts, confirm the terms and conditions of each font before use. 

 

・ After downloading, if you want to change characters with actions and/or host communication, 

you will need to register the image font beforehand. For more information, please refer to 

13.6 Image Font Registration. 

 

・ If the PC on which the project is edited is changed, there may be a situation where the fonts 
used in the project are not installed on the PC. In this case, an error dialog will appear when 
you open the project. Please install the target font or change the font settings to resolve the 
error. You can check the error location by performing an "Error check". For more information 
on error checking, please refer to 14.6 Error check. 
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5.4.4 Change Color 

This section describes how to change the color of character. 

Procedure 

1.  Select the Part. 

 

 

2.  In the property area's [Color] category, click [Character]. 

 

* You can also set from the parts [Advanced Properties] dialog box. 

 

3.  Select a color from the color palette. 

 

 

4.  Character is changed to the selected color. 
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5.5 Change Color of Parts 

 

This section explains how to change the color of Parts. 

5.5.1 Change Color of Base Screen 

Change the background color of the Base Screen and the Pop-up Screen. 

Procedure 

1.  Select the Base Screen. 

 

 

2.  In the property area's [Color] category, click [Background]. 

 

* You can also set from the parts [Advanced Properties] dialog box. 

 

3.  Select the desired color from the color palette. 

 

 

 



5. Create a Screen  

InfoSOSA Builder Operation Manual 90 

4.  Background will be changed to the selected color. 

 

 

5.5.2 Change Color of Parts 

This section explains how to change to the color of Parts. 

Procedure 

1.  Select the Parts. 

 

 
2.  In the property area's [Color] category, select [Background]. 

 

* You can also set from the parts [Advanced Properties] dialog box. 

 

3.  Select a color that you want to set from the color palette. 

 

 
 

4.  The selected color will be displayed on the Part. 

  

 

Change Color of Frame. 
* Only NoImage Frame 

Change Color of Parts. 
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5.5.3 Parts Transparency Settings 

This section describes the transparent setting of Parts. 

When the transparency is set, the color around the main Part (area that is the same color as the 

upper left corner of the Part) becomes transparent. 

Procedure 

1.  Select the Parts. 

 

 
2.  In the property area's [Color] category, from the [Transparency] menu, select [True]. 

 

* You can also set from the parts [Advanced Properties] dialog box. 

 
3.  The back area of the selected Part becomes transparent. 

 

 

Select [True]. 
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5.6 Paste Image 

 

This section describes the procedure to paste images of the screen or Parts. 

To use an image, first you need to register the image to the image resource. 

5.6.1 Paste Image to the Screen 

Paste the image to the Base Screen or Pop-up Screen. 

Procedure 

1.  Select Screen. 

 

 
2.  In the property area's [Image] category, from the [Normal Image] menu, select the image ID 

of the image to paste. 

    

 

* You can also set from the parts [Advanced Properties] dialog box.  

In the [Advanced Properties], you can select while checking the image. 

 
3.  The selected image will be displayed in the background. 

  

Caution 
When the size of the image on the screen and 
the actual size of the image are different, 
image scaling is done automatically. 
If the size of the image to register matches the 
size on the Base screen, no additional data is 
created, thus reducing the size of the project 
data. 

The [Image ID] 
registered to the 
image resource is 
displayed. 
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5.6.2 Paste Image to Parts 

This section describes how to paste the image to Parts. 

Procedure 

1.  Select the Parts. 

 

 
2.  In the property area's [Image] category, from the [Normal Image] and [Action Image] menus 

select the image ID of the image to paste. 

 

 

* You can also set from [Advanced Properties].  

In the [Advanced Properties] dialog box, you can select while checking the images. 

 

3.  The selected images will be displayed in the Parts. 

 

 
 

Image When Normal 

Image When Active 

Displays the [Image ID] as registered in 
[Image Resources]. 

Caution 
When the size of Parts and the size of images are different, image 
scaling will be done automatically. 
If the size of the image to register matches the size of the Part, no 
additional data is created, thus reducing the size of the project data. 
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5.7 Parts and Link Data (Memory)  

 

This section describes how to link Parts and memory. 

It is possible to link memory and string resources to the placed Parts. 

Linked memory or string resource will act as the state or the character displayed on the Part. 

Memory and string resources will need to be registered beforehand. 

For more information about each item, please refer to the "Reference Manual". 

5.7.1 Link to Memory of Parts 

Link the registered memory to the Parts. 

Procedure 

 

1.  Select the Parts. 

 

 
2.  Select the type of memory to link. From the property area, use the [Link Data] category's 

[Memory Type]. 

 

 

3.  Select the memory to link. From the property area, use the [Link Data] category's [Memory 

ID] menu. 

 

* You can also set from [Advanced Properties]. 
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5.8 Property Setting of Parts 

 

This section describes how to set the property of Parts. 

Each Part has properties. 

Setting of Parts is done by changing the values in the property. 

Setting properties are done through [Property Area] and [Advanced Properties]. 

* Details and each item of property vary according to the Parts. 

5.8.1 Property Area 

Property area is an area on the screen of the InfoSOSA Builder for setting values of the standard 

properties. 

Select the Parts that you want to set, and make the setting directly from the screen. 

 

 
  

Property Area 
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5.8.2 Advanced Properties 

The Advance Properties is a dialog that allows you to set the properties that have been prepared 

for each Part. 

The dialog box contents vary with each Part. 

Advanced Properties Dialog 

Displaying the Advanced Properties Dialog 

1.  Select the Part and right-click. From the menu, select [Advanced Properties]. 

 Or double-click the Part. 

 

2.  Advanced Properties Dialog is displayed. 

The dialog box contents vary with each Part. 

For more information about each item, please refer to the "Reference Manual". 
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5.9 Draw Figures 

 

This section describes the Figure Parts. 

5.9.1 Line-Arrow Parts 

You can freely draw lines and arrows. 

Placement Procedure 

1.  Click on the Line Parts or the Arrow Parts of the Toolbox. 

 

 

2.  Left-click the screen and drag to display a rectangle. 

   

 

  

Start point 

End Point 
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3.  Release the left-click and a line from the start point to the point where you released the 

left-click will be drawn. 

   

 

In the case of the arrow, the arrow will be marked at the end point. 

 

 

Click "Pointer" to release the drawing state. 

 

 

  

End Point 
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Change Line Angle and Length 

1.  Select the Line Part or Arrow Part. 

   

 

2.  Click on the end of the line, hold and drag to freely change the length or the angle of the line 

or arrow with the released end as fulcrum. 
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If you want to make the lines horizontal or vertical, use the "Snap to Grid" function. 

 

 

 

The start and end points will be attached to the grid lines, so you can set them horizontally or 

vertically. 
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Change Line Type and Color 

1.  Right-click on the line Part or arrow Part, and select [Advanced Properties] 

   

Or double-click the line Part or arrow Part. 

 

 

2.  From the [Advanced Properties Dialog], click the [Extended Property] tab. 

   

 

3.  Change line type, line color, and arrow by changing the properties in [Line, Arrow,  

Rectangle Parts]. 
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5.9.2 Rectangle Parts 

This section describes how to draw a rectangle. 

 

Placement Procedure 

1.  Click on the Rectangle Parts from the Toolbox.. 

 

 

 

2.  Left-click the screen and drag to display a rectangle. 
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3.  Release the left-click and a rectangle is drawn. 

   

 

Change Position and Size 

You can change the above in the same way as ordinary Parts (such as a button). 

 

 

 

Change Line Type, Color and Background 

1.  Right-click the rectangle part, and click [Advanced Properties]. 

   

Or double-click the rectangle Part. 
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2.  From the [Advanced Properties Dialog], click [Extended Property]. 

   

 

3.  Change Line Type, Line Color, Paint Background (Fill/ No Fill), and Background Color by 

changing the properties under "Line, Arrow, Rectangle Parts". 
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5.10 Create Tables 

 

This section describes the Table Parts. 

Placement Procedure 

1.  Click the Table Parts of the Toolbox. 

 

 

 

2.  The [Table Setting] dialog box is displayed when you left-click on the screen. Select the 

number of rows and columns and click [OK]. 

 

 

3.  Table is placed on the screen. 
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Change Position and Size 

You can change the above in the same way as ordinary Parts (such as a button). 

 

 

Change Grid Line Style and Color 

1.  Right-click the Table part and click [Advanced Properties]. 

 

Or double-click the table Part. 

 

2.  From the [Table Setting Dialog], click [Extended Property]. 
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3.  In the [Grid Line] properties, you can change the line type and line color. 

 

* [Grid Line] properties define the grid settings for the entire table. 

 

 

Insert Row/Column 

1.  Open the Table Part's [Extended Property]. 

 

 

2.  Right-click the column heading. 
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3.  Click [Insert Column/Row]. 

    

 

4.  Column/row will be added to the left/top. 

    

 

Delete Row/Column 

1.  Open the Table Part's [Extended Property]. 
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2.  Right-click the column heading. 

   

 

3.  Click [Delete Column/Row]. 

   

 3.  Column/row will be deleted and the cells will move up or to the left. 
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Change Size of Row/Column 

1.  Open the Table Part's [Extended Property]. 

 

 

2.  Move the cursor to the separator line of row/column. 

   

* Mouse pointer will be displayed as follows on the separator line. 

 Column “     “, Row “  “ 
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3.  The size can be changed by dragging. 
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Align Size of Row/Column 

1.  Open the Table Part's [Extended Property]. 

 

 

2.  Right-click the column heading. 

    

 

3.  Select the [Align Width/Height of Column/Row]. 
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 4.  The size of the column/row is aligned to the selected column/row. 

   

 

Change Pattern and Background Color of Cells 

1.  Open the Table Settings Dialog's [Extended Property] tab. 
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2.  Select the cells that you want to change. 

 

 

3.  Change the properties of the Background Color to change the Cell Color and Background. 

 

* Background Color can be set individually to each cell. 

* Multiple cells can be selected simultaneously by clicking on the cells while holding down 

the shift and control key at the same time. 
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6. Display Settings of Drawing 
Area 

 

 

 

Chapter Contents 
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6.5  Display of Touch Panel Button .................................................................. 122 
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6.1 Magnify the Display 

 

Magnifying the drawing area. 

* Display magnification is a drawing function. The magnification settings do not influence 

operations after download. 

 

Procedure 

1.  Move the slider on the Screen Editor screen. 

 

 
 

Or change it directly by entering the magnification. 
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2.  The display magnification is changed. 
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6.2 Set Grid 

 

It is possible to facilitate the positioning of the Parts to be arranged in a drawing by using a grid. 

6.2.1 Show Grid 

Display the grid on the drawing screen. 

Procedure 

1.  From the [Display] menu, select [Show Grid]. 

 

You can do the same with a toolbar icon . 

 

2.  Grid is displayed on the screen. 

   

 

3.  To hide the grid, repeat the step again. 
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6.2.2 Snap to Grid 

Parts are placed to align with the grid. 

Procedure 

1.  From the [Display] menu, select [Snap to Grid]. 

 

You can do the same with a toolbar icon . 

 

2.  When placed or moved, etc. of Parts will be placed on the grid. 

Go through the above procedure again and the setting will be canceled. 

6.2.3 Change Display Dot Width of Grid 

Set the display dot width of the grid. 

Procedure 

1.  From the [Display] menu, select [Grid Width]. 

Select the dot width to set. 

  

You can do the same with a toolbar icon . 

 

2.  The grid interval is set to the [Display Dot Width]. 
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6.3 Display of Parts Area 

 

When you enable the display function of the Parts area, the outlines of Parts are displayed with a 

broken line, which makes it easier to determine the position and size of the Parts. 

 

Procedure 

1.  From the [Display] menu, select [Parts Area].  

 

You can do the same with a toolbar icon . 

 

2.  Parts area is displayed on the screen. 

   

 

3.  Parts area display will disappear with the same procedure. 
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6.4 Change Display Language 

 

The InfoSOSA builder can change between Japanese and English display.  

Procedure 

1．From the [Display] menu, select [Language]. 

Choose the language to set. 

   

 

2．InfoSOSA has to be restarted for the change to take effect. 

Please click the “OK” button. 

 

 

3．If the the project has not been saved, a confirmation dialog will be displayed. 

Click "Yes" or "No". 

  

 

4．After restarting InfoSOSA Builder, the language will be switched to the selected language. 
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6.5 Display of Touch Panel Button 

 

When checking/editing parts placed under the touch panel button, the touch panel button can be 

temporarily hidden. 

Procedure 

 
1.  From the [Display] menu, select [Touch Panel Button].  

 

You can do the same with a toolbar icon . 

 

 

2.  The touch panel buttons are hidden.  
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3.  Select it again to display the touch panel buttons. 

     

 

 

This function is for checking/editing the part temporarily placed under the touch panel button. 

The display/non-display state of the touch panel buttons does not affect operation after 

download. 

The following operations automatically return the touch panel buttons to the display state. 

◼ New touch panel button layout 

◼ Screen switching (screen list area touch) 

◼ project open 
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7. Setting Image Resources 

 

 

 

Chapter Contents 

7.1  Image Resource ........................................................................................ 125 

7.2  Register and Edit Images .......................................................................... 127 
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7.1 Image Resource 

 

To use an image file in InfoSOSA Builder, the image file must be registered to the Image 

Resource. 

The file format that can be registered to the Image Resources are BMP (24bit color, 256-color 

index color), JPEG · JPG, GIF and PNG. 

The maximum size and maximum number of images you can register in the Image Resource 

depend on your model. 

For more information, please refer to the "InfoSOSA Reference Manual". 

Image registered to the Image Resource can be used by linking to the Parts arranged on the 

screen. 

7.1.1 Image Resource Screen 

Image Resource screen is displayed when you select the [Image Resource] tab in the drawing 

area. 

Image registration, editing and creating a new image is possible in the Image Resource Screen. 

 

 
 
  

Select an Image Resource 
The screen displays the registered 
image. 
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7.1.2 Image Resource Information 

The information of the registered image can be checked and edited by the Image Resource 

Information. 

Procedure 

When you select an image in the [Image Resource] screen, details are displayed in the [Image 

Resource Information]. 

After editing the [Image ID] and [Comment], click [OK]. 

 

 

No Item Contents 

①  File Name File name defined at Image Resource registration 

②  File Path Original image address 
Empty if acquired from the clipboard. 
*Actual image data will be stored in ipp file, editing of imported image will not 
be reflected. 

③  Image ID ID to access image. 
Specify ID at time of action setting or link setting. 

④  Comment Remarks 
Useful when using only image ID is confusing. 
* Comments are not mandatory. 

 

④ 
③ 

② 

① 
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7.2 Register and Edit Images 

 

7.2.1 Register Images 

Register image files one by one as Image Resources. 

Procedure 

1.  Click [Add File] in the Image Resource screen. 

 

2.  [Add Image Resource Dialog] is displayed. 

Click [Browse]. 
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3.  Select the image to register and click [Open]. 

  * When you change a bitmap file (*.bmp), you can also select other file formats. 

 

 

 

 

 

 

 

 

 
4.  Edit the [Save File Name], [Image ID] and [Comment] fields. 

Click [Add]. 

  

* Comment is not mandatory. 

  

◆  If the image you want to register is "read-only", remove the 

read-only flag before registration. 
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5.  The image is registered to the Image Resource. 
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7.2.2 Batch Register Multiple Images 

Register image file as an Image Resource by folder batch. 

Procedure 

1.  Click [Add Batch] in the Image Resource screen. 

 

2.  [Add Image Resource Batch Dialog] is displayed. 

Click [Browse]. 

  

 

3.  Select a folder to capture and click [OK]. 

 

 

 

 

 

 

 

 

  

◆ If the image you want to register is "read-only", remove the 

read-only flag before registration. 
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4.  Click [Add]. 

 

 
 

5.  Multiple Images in the specified folder will be registered to Image Resource. 
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7.2.3 Registering Images (Drag & Drop) 

Drag and drop image files to register them. *Ver. 2.7 or later 

 

Procedure 

1.  Displays the Image Resources screen. 

 

 

 

 

2.  Drag and drop the image file to be registered from Explorer. (Multiple) 

 

 

 

 

 

 

 

 

 

 

 

 

  

◆ If the image you want to register is "read-only", remove the 

read-only flag before registration. 
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7.2.4 Copy Image 

Copy the registered image (Image Resource). 

Procedure 

1.  Select the image to copy in the Image Resource screen. 

After selecting, click [Copy] and [Paste].  

 

 
2.  [Copy Image Dialog] dialog box is displayed. 

Edit [File Name], [Image ID] and [Comments], and then click [Copy]. 

 

* Comment is not mandatory. 

 
 

3.  Copied image is registered to the Image Resource. 
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7.2.5 Create New Image 

Create a new image and register as an Image Resource. 

* Image editing software must be installed in the computer to use this function. 

Example) Microsoft Paint 

Procedure 

1. Click [Create New] in the Image Resource screen. 

 
 
2. [Create New Image Resource Dialog] is displayed. 

Edit [File Name], [Image ID], [Comment], [Height] and [Width], and then click [Create]. 

 

 
3. Starts the image editing software defined in the [System Settings] [Standard Color Setting] field.

Use the image editing software and create an image. 

 

* If the specified image editing software cannot be found, the default image editing software will 

be launched. 

 

 

4. After creating, save the image and it will be registered to the Image Resource. 
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7.2.6 Edit image 

Edit the registered image in the Image Resources. 

* In order to use this function, the image editing software must be installed on the PC.  

Example) Microsoft Paint 

Procedure 

1.  Select the image to edit in the Image Resource screen. 

After selection, click [Edit]. 

 

 
2.  Starts the image editing software defined in the [System Settings] [Standard Color Setting] 

field. 

Use the image editing software and edit the image. 

 

* If the specified image editing software cannot be found, the default image editing software will 

be launched. 

 

 

3.  Save the edited image and it will be registered to the Image Resource. 

 

 

 

 

 

 

 

 

  

◆ Make sure you select [Save]. If you save with a different file name, 

it may not be recognized. 
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◆You can delete multiple images at once by selecting them while 

holding down the Shift key (or Ctrl key). * Ver. 2.7 or later 

7.2.7 Delete Image 

Delete the registered image in the Image Resources. 

Procedure 

1.  Select the image to delete in the Image Resource screen. 

After selecting, click [Delete]. 

 

 

 
2.  Image is deleted. 
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7.2.8 Exporting Images 

Extracts the image resources registered in the project as a file. 

* Ver. 2.7 or later 

 

Procedure 

1.  Drag and drop the image you want to retrieve from the Image Resources screen into the 

Explorer, or hold down the Shift key (or Ctrl key) to select multiple images. 

 

 

 

 

 

 

 

 

 

 

 

The image will be exported. 
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8. Set String Resources 

 

 

 

Chapter Contents 

8.1  String Resources ....................................................................................... 139 

8.2  Register and Edit the String Resources .................................................... 141 

8.3  Register and Edit of String Resource Set .................................................. 149 
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8.1 String Resources 

 

In the String Resource screen, it is possible to manage and register as resource the strings used 

when creating a screen. 

You can register multiple strings as one associated string. 

Character registered to the string resource can be displayed by linking to labels, etc. 

Labels display characters corresponding to the current string mode of the linked string resource 

set. Changing the current string mode changes the display characters of all Parts linked to the 

string resource set. 

When changing the initial value of the string mode, from the toolbar's [String Resource Set] 

select the [String Resource Set Name]. 

When making a change during operation, use action settings or host communication commands 

to define the [String Resource Set ID] in the environment variable [STRMODE]. 

8.1.1 String Resources Screen 

String Resources Screen appears when you select the editor display area's [String Resources]. 

In the String Resources screen there are [Edit Screen] and [String Resource Set Management]. 

 

 

  

 
Select from [Edit] or [String Resource 
Set Management]. 

Select [String Resource] 
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8.1.2 Edit Screen 

You can register/edit the String ID on the edit screen. 

For one String ID, you can register the same number of strings registered to the string resource 

set. 

 
 

 

 
 
 
 

8.1.3 String Resource Set Management 

Registration and editing of String Resource Set ID and String Resource Set Name is done on the 

String Resource Set Management. 

 

 

The initial value of the string mode is set in the toolbar's [String Resource Set]. 

* [String Resource Set Name] is displayed. 

* String mode is a common setting for all string resources. 

 

Example) If the two strings resource set registered to the string resource is displayed linked to 
labels: 

Japanese                  English 

            

   

Displays the [String Resource Set Name] as registered in [String Resource Set 
Management] screen. 

Register a string. 
You can register a different string in each String 
resource set. 

Register the 
String ID used 
when accessing 
the string. 
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8.2 Register and Edit the String Resources 

 

8.2.1 Register the String Resources 

This section explains how to register a new String ID. 

 

Procedure 

1.  From the [Edit] tab click [Add]. 

 

 

2.  A new [String ID] is added. 

 

 
 

3.  You can change the [String ID] directly from the list. 

 

* Characters you can use for the ID are alphanumeric characters, hyphen (-), and 
underscore (_). (However, the first character must be a letter.) 
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8.2.2 Edit String Resources 

This section explains how to edit a string. 

Procedure 

1.  The [String configuration dialog] appears when you click a column in the [String Resource 

Set Name]. 

 

 

2.  Please enter the string in the [String configuration dialog]. 

* Up to 256 characters. (Single and double-byte characters are both counted as one character. Line 

break is counted as two characters.) 

 

 

 
 

3.  It will be set when you click anywhere outside the dialog. 

 

 

* You can adjust the display area of the string with icon  at the bottom of the screen. 

 

If the [String Resource Set 
Name] is not registered, it 
displays "No Settings". 
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8.2.3 Copy String Resources 

This section explains how to copy a string. 

Procedure 

1.  From the [Edit] tab, select the string you want to copy. 

 

 

 
2.  Click [Copy] and [Paste]. 

  

 
3. String is copied. * String ID is assigned automatically. 
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◆You can delete multiple strings at once by selecting them while 

holding down the Shift key (or Ctrl key). * Ver. 2.7 or later 

8.2.4 Delete String Resources 

This section describes how to delete a string. 

Procedure 

1.  From the [Edit] tab, select the string you want to delete. 

 

 
2.  Click [Delete]. 

 

 
3.  String is deleted. 
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8.2.5 Exporting/Importing String Resources 

Export/import to/from external editors via clipboard. *Ver. 2.7 or later 

 

Export procedure 

1.  From the "Edit" tab, select the text to be exported. 

You can select multiple lines by holding down the Shift key (or Ctrl key) while clicking. 

 

 

 

2.  Click [Copy]. 

 

 

The string resource will be copied to the clipboard as TAB-delimited text data. 

 

3.  Open an external editor, such as a spreadsheet or text editor, and paste (ctrl+v) from the 

clipboard. 

 

 

 

 

 

The clipboard data will be exported to an external editor. 

 

You may not be able to export depending on the specifications of the external editor you are 
using. For details, please refer to "Import/Export Formats" below. 
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Import procedure 

1.  After modifying/adding in an external editor, select a range and copy it to the clipboard 

(Ctrl+c). 

 

 

 

 

 

2.  Return to the InfoSOSA Builder and click the [Paste] button on the “Edit” tab. 

 

 

For more information, see "Import/Export Formats" below. For details, please refer to 
"Import/Export Formats" below. 

 

3.  If you want to overwrite, select [Yes]. Select [No] to add a new ID. 

 

 

 

4.  The data in the clipboard will be imported. 
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Import/Export Formats 

The InfoSOSA Builder exports/imports string resources as text data in the following data formats 

 

[Data format] 

 

 

 

 

 

 

 

 

 

 

 

One line is one string resource. If you are copying multiple string resources, you will get multiple 
lines. 

 

 

Item contents 

No Serial number of the string resource. 
It will be automatically reconfigured upon import. 

ID String ID (maximum 8 characters) 
The characters that can be used for ID are single-byte alphanumeric 
characters and [-][_]. (However, the first character must be an alphabetic 
character.) 

S1～S10 String for each string resource set 
To include a newline in the string, enclose the string in "" (double quotation 
marks). The line feed code in the string is LF (0x0a). 
The number of strings must match the number of string resource sets 
registered in the project you are importing from. 

<TAB> Indicates TAB (0x09) 

<CR><LF> When there are multiple string resources, they are separated by 
CRLF(0x0d,0x0a). 

 

 

 

 

 

 

  

No<TAB>ID<TAB>S1<TAB>S2<TAB>S3…S10<CR><LF> 

No<TAB>ID<TAB>S1<TAB>S2<TAB>S3…S10<CR><LF> 

No<TAB>ID<TAB>S1<TAB>S2<TAB>S3…S10<CR><LF> 
・ 
・ 
・ 

◆ If the external editor you are using does not support this data 

format, you may not be able to export/import it. 
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8.2.6 Sorted display of String Resources 

This function makes it easier to find the desired string resource by sorting it by the specified item. 

*Ver. 2.7 or later 

 

Procedure 

Click the header of the column you want to use as the basis. 

Each time you click on the column header, the order changes from descending to ascending to 

cancel. 

 

 

 

 

ID sort 

 

 

String sort 

 

 

 

 

 

Click here 

 

Click here 

 

◆ The sorted display is temporary. When the project is opened, it will 

be in a canceled state. 
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8.3 Register and Edit of String Resource Set 

 

8.3.1 Register of String Resource Set 

This section explains how to register a String Resource Set. 

 

Procedure 

1.  From the [String Resource Set Management] tab, click [Add]. 
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2.  A new [String Resource Set] is added. 

 

 
 

3.  You can change the [String Resrouce Set ID] directly from the list. 

 

* Characters that can be used for ID are alphanumeric characters, hyphen (-), underscore (_), 
and special ID that begin with the @ symbol (Define Font String Resource Set ID). 

* First character must be a letter. (Except for Define Font String Resource Set ID) 

 
 
 
 
 
 
 
 
  

◆ You can prioritize and display the defined font by specifying the 

String Resource Set ID in [Define Font String Resource Set ID]. 
For more information, please refer to 13.4 System Font Settings. 
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8.3.2 Edit String Resource Set Name 

This section explains how to edit a String Resource Set Name. 

Procedure 

1.  In the [String Resource Set Management] tab, edit by directly entering the [String Resource 

Set Name] in the [String Resource Set]. 

 

 

String Resource Set Name will be displayed in the "String Resource Set" in the toolbar. 
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8.3.3 Copy String Resource Set 

This section explains how to copy a String Resource Set. 

Procedure 

1.  From the [String Resource Set Management] tab, select the [String Resource Set] that you 

want to copy, and click [Copy] and [Paste]. 

 

 

2.  String resource set will be copied. 
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◆You can delete multiple String Resource Set at once by selecting 

them while holding down the Shift key (or Ctrl key). * Ver. 2.7 or later 

8.3.4 Delete a String Resource Set 

This section describes how to delete a String Resource Set. 

* At least one String Resource Set ID is required. 

Procedure 

1.  From the [String Resource Set Management], select the string resource set you want to 

delete and click [Delete]. 

 

 

2.  String resource set ID will be deleted. 
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9. Sound Resource Settings 

 

 

 

Chapter Contents 

9.1  Sound Resources ...................................................................................... 155 

9.2  Register and Edit Sounds .......................................................................... 156 
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9.1 Sound Resources 

 

To use a sound in InfoSOSA, the sound file must be registered to the Sound Resources. 

You can register linear pulse code modulation (LPCM) WAV files into Sound Resources. 

The maximum file size you can register in the Sound Resources is 16MB per file. 

You can use sound files registered in the Sound Resources with actions or host communication. 

9.1.1 Sound Resources Screen 

The Sound Resources screen is displayed when you select the [Sound Resources] tab in the 

drawing area. 

In the Sound Resources screen you can register and delete sound files. 

 

 
 

Select Sound Resources 
The screen displays the registered 
sound files. 
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9.2 Register and Edit Sounds 

 

9.2.1 Register Sound Resources 

This section explains how to register a Sound Resource. 

Procedure 

1.  Click [Add File]. 

  
 

2.  Select the file to register and click [Open]. 

 

 
 
 
 
 
 
 
 

3.  The file is registered to Sound Resources. 

 

  

◆ If the sound you want to register is "read-only", remove the 

read-only flag before registration. 
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9.2.2 Registering Sound Resources (Drag & Drop) 

Drag and drop sound files to register them. *Ver. 2.7 or later 

 

Procedure 

1.  Displays the Sound Resources screen. 

 

 

 

2.  Drag and drop the sound file to be registered from Explorer. (Multiple) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
  

◆ If the file you want to register is "read-only", remove the read-only 

flag before registration. 
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9.2.3 Update Sound Resources 

This section explains how to update registered Sound Resources. 

As registered Sound Resources are imported into in the project file, even if you update the 

original file, the sound in the project is not updated. To update, follow the steps below. 

 

Procedure 

1.  Double-click [File path]. 

 

 
 
 

2.  Select the file to register and click [Open]. 

 

 
3.  The Sound Resource replaces the selected file. 
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◆You can delete multiple Sound Resources at once by selecting 

them while holding down the Shift key (or Ctrl key). * Ver. 2.7 or later 

 

9.2.4 Delete Sound Resources 

This section explains how to delete registered Sound Resources. 

 

Procedure 

1.  Select the sound to delete in the Sound Resources screen. 

After selecting, click [Delete]. 

 

 
2.  The Sound Resource is deleted. 

 

 
 
 
 
 
 
 
 
 
 

9.2.5 Test playback of Sound Resources 

This section explains how to play registered Sound Resources. 

 

Procedure 

1.  Select the sound to play in the Sound Resources screen. 

After making your selection, click [Play]. 

 

 

The registered sound file plays back once. 

To stop playback of the file partway through, click [Stop]. 

 
  



9. Sound Resource Settings  

InfoSOSA Builder Operation Manual 160 

 

9.2.6 Exporting Sound Resources 

Extracts the sound resources registered in the project as a file. 

* Ver. 2.7 or later 

 

Procedure 

1.  Drag and drop the sound you want to retrieve from the Sound Resources screen into the 

Explorer, or hold down the Shift key (or Ctrl key) to select multiple sound. 

 

 

 

 

 

 

 

 

 

 

The sound will be exported. 
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9.2.7 Sorted display of Sound Resources 

This function makes it easier to find the desired sound resource by sorting it by the specified item. 

*Ver. 2.7 or later 

 

Procedure 

Click the header of the column you want to use as the basis. 

Each time you click on the column header, the order changes from descending to ascending to 

cancel. 

 

  

 

ID sort 

  

 

File sort 

 

 

Comment sort 

  

 

 

 

 
 

 

 

 

Click here 

 

Click here 

 

◆ The sorted display is temporary. When the project is opened, it will 

be in a canceled state. 

Click here 
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10. Memory Set up 
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10.1 Memory 

 

The memory is an internal variable used in the InfoSOSA. 

There are two kinds of memory. One is screen memory and the other is global memory. 

"Screen Memory" is a memory that is set on the screen and cannot be accessed from another 

screen like the Parts that were placed on the screen. 

"Global Memory" is a memory accessible from all screens. 

Memory type is used depending on the intended use. 

Also, there is the environment variable as InfoSOSA specific variables. 

* For more information about each item, please refer to the "Reference Manual". 

10.1.1 Types of Memory 

There are integer types (boolean, byte, word, double word), string type, timer type, and array 

queue type (Screen Memory only) for the Screen Memory and Global Memory. 

Integer type is a signed integer except for Boolean. 

Memory type Contents 

Boolean Two values, true (True, 1) or false (False, 0). 

Byte 1 byte signed integer. (-128 To 127) 

Word 2-byte signed integer. (-32,768 To 32,767) 

Double word 4-byte signed integer. (-2,147,483,648 To 2,147,483,647) 

String Uses string 

Timer Generates events at specified time 

Array queue Simple Graph only 

10.1.2 Memory Screen Item 

The list below will be displayed in the Screen Memory area and the edit screen of Global 
Memory. 

 

 

No Item Contents 

① Memory ID Register ID to use when linking to Parts. 

② Type Select type to use. 

③ Size In [String Type], set the character length. 

④ Initial value Register value to set as initial value. 

⑤ Comment If set up, displays behind the memory ID when setting up Link or Action 
Settings. 
Useful when using only memory ID is confusing. 

⑥ Digest Displays setting contents of memory. 

 

④ ⑥ ⑤ ③ ② ① 
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10.1.3 Screen Memory 

Screen Memory is a memory that shares the variable (parameter) of Parts state of the same 

screen or holds the value temporarily. It can be changed only from the screen it was registered in 

and not from the other screens. 

In addition, when the screen is displayed, it loads the initial value every time. 

Screen Memory Area 

Screen Memory Area is located at the bottom of the screen editor. 

It is prepared for each base screen. 

Registration and editing of Screen Memory can be done in the Screen Memory Area. 
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10.1.4 Global Memory 

Global Memory is a memory that can be used from all screens. 

You can manage Multiple Global Memory as one group. 

Global Memory Screen 

Global Memory is displayed when you select the [Global Memory] tab in the drawing area. 

The Global Memory Screen has [Edit] and [Group Setting] tabs. 

Edit screen 

Registration and editing of Global Memory can be done on the edit screen. 

 

  

Select [Global Memory] tab 

Select the [General] tab 
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Group Setting Screen 

Group Setting of Global Memory can be done in the Group Setting Screen. 

 

 

Select [Global Memory] 

Select [Group Setting] 
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10.2 Basic Setting of Memory 

 

Each of the memory registration and editing can be done by the buttons shown below that are 

provided on the Screen Memory Area and/or edit screen of Global Memory. 

 

10.2.1 Register Memory 

Newly register the memory. 

Procedure 

1.  Click [Add]. 

 

 
2.  The new memory will be displayed. 
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10.2.2 Copy Memory 

Copy the memory. 

Procedure 

1.  Select the memory that has been registered. 

 

 

2.  Click [Copy] and [Paste]. 

 

 
3.  Copied memory will be added. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

◆ You can copy multiple memories at once by holding down the 

Shift key (or Ctrl key) while selecting them. * Ver. 2.7 or later 
 

◆ “Screen Memory” and “Global Memory” can be copied to each 

other. * Ver. 2.7 or later 
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◆You can delete multiple memories at once by selecting them while 

holding down the Shift key (or Ctrl key). * Ver. 2.7 or later 

10.2.3 Delete Memory 

Delete the memory. 

Procedure 

1.  Select the memory that has been registered. 

 

 

2.  Click [Delete]. 

 

 
3.  The selected memory will be deleted. 
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10.2.4 Action Setting of Memory 

Set the action settings for memory. The memory types that can be set for actions are "Numeric" 

and "Timer". If you want to set an action for a numeric type, you need to set the 

"OnChangeValueEvent" of the memory to "Available". 

 

Procedure 

1.  Select the memory that has been registered. 

 

 

2.  Click [Action]. 

 

 
3.  [Action Settings Dialog] is displayed. 

Set the action in the same way as the Parts. 
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10.2.5 Edit Memory (Direct Input) 

Edit directly from each item in the list of registered memory. 

The items that can be directly edited are [Memory ID], [Size], [Initial Value] and [Comment]. 

[Size] can be edited only for the String Type memory. 

Procedure 

1.  Edit each item directly. 

 

 
 

For String Type memory, [String configuration dialog] is displayed. 

* You can enter up to the [Size] value. (Single and double-byte characters are both counted as one 

character. Line break is counted as two characters.) 

 

* The size of the display area can be adjusted by the icon  at the bottom of the screen. 
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10.2.6 Edit Memory (Property Screen Display) 

Edit the registered memory in the [Advanced Properties Dialog]. 

Items that are not listed and/or cannot be edited directly can also be edited. 

Procedure 

1.  Select the memory that has been registered. 

 

 

2.  Click [Property]. 

 

 

3.  [Advanced Properties Dialog] is displayed. 

Select and edit each item. 

Items that can be set vary by memory type. 

 

* If memory type is changed between byte, word and double word, the setting for the maximum and 

minimum values before the change are stored. 
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10.2.7 Sorted display of Memory 

This function makes it easier to find the desired Memory by sorting it by the specified item. 

 *Ver. 2.7 or later 

 

Procedure 

Click the header of the column you want to use as the basis. 

Each time you click on the column header, the order changes from descending to ascending to 

cancel. 

 

 

 

 

 

 

 

 

 

 

 

ID sort 

 

 

  

Click here 
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Type sort 

 

 

 

 

 

 

Comment sort 

 

 

 

 

 

  

 

 

 

 
 

 

 

 

 

Click here 

 

◆ The sorted display is temporary. When the project is opened, it will 

be in a canceled state. 

Click here 
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10.3 Group Setting of Global Memory 

 

Multiple Global Memories can be managed as one group. 

If you set the Group Memory, you will be able to read and write the values of several Global 

Memories with a single command. 

Group Setting of Global Memory is done on the Group Setting Screen of Global Memory. 

 

 

Use the following buttons which have been prepared on the group setting screen 

 

  

Select [Global Memory] 

Select [Group Setting] 
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10.3.1 Register of Group Memory 

Add a new Group Memory. 

Procedure 

1.  Click [Add]. 

 

 
2.  A dialog box appears. Select the memory you want to add to the group and click [→].  

* You can select multiple memory by holding down the [Shift] or [Ctrl] keys. 

 

 
3.  Register to the group memory. 

Repeat step 2 if necessary. 

When all the registration is complete, click [OK]. 

 

* If your registration is incorrect, select the memory you want to return and click [←]. 

* The Global Memory will be sorted in alphabetic order. 

  



10. Memory Set up  

InfoSOSA Builder Operation Manual 177 

 

10.3.2 Delete Group Memory 

Delete a registered Group Memory. 

Procedure 

1.  Select the Group Memory that you want to delete. 

 

 

2.  Click [Delete]. 

 

 
3.  Group Memory will be deleted. 
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10.3.3 Edit Group Memory 

Change the settings for the registered Group Memory. 

Procedure 

1.  Select the Group Memory that you want to edit. 

 

 

2.  Click [Property]. 

 

 
3.  Change the settings in the [Group Settings Dialog]. 
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11. Action Settings 

 

 

 

Chapter Contents 

11.1  Action Settings......................................................................................... 180 

11.2  Subroutine ............................................................................................... 199 
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11.1 Action Settings 

 

You can set the action (operation) for each event that occurs from the placed Parts. 

You can set from the [Action] tab of the [Advanced Properties Dialog]. 

* For more information about the items in the events and actions, please refer to the "Reference Manual". 

11.1.1 Display of Action Setting 

 

Procedure 

1.  Select and right-click the Parts on the screen editor. 

From the menu, select [Advanced Properties]. 

 

From the [Advanced Properties Dialog], click [Action]. 
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2.  [Action Settings] is displayed. 

 

 

 

* You can also use the right-click menu's [Action Settings] command to open it directly. 
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11.1.2 Action settings 

Set actions from the [Action Settings Dialog]. 

Procedure 

1.  From the [Action Settings Dialog] [Event] list, select the action that will run the event. 

After selecting, click [Add]. 

 

 

2.  The [Action Settings Dialog] is displayed. 
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3.  From the [Action Group] list, select the action group to set. 

 

 
4.  from the [Action] area, select the action to set. 

 

 
5.  Set each parameter. 

When all the settings are complete, click [OK]. 

 

* Contents of action setting depends on the selected action. 



11. Action Settings  

InfoSOSA Builder Operation Manual 184 

 
6.  Contents of the action settings are added to the [Action Settings Dialog]. 

Click [OK]. 

 

 

If you want to add another action, repeat steps 1 to 5. 
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11.1.3 Copy Action 

Copy and add a registered Action. 

Procedure 

1.  Select the action to copy from the [Action Settings Dialog]. 

After selecting, click [Copy]. 

 

 

2.  Click [Paste]. 

 

 
3.  Copied action is added. After adding, click [OK]. 

 

 

 

 

  

◆ From Ver. 2.7, it is now possible to paste a copied action to 

another part. 
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11.1.4 Delete Actions 

Delete a registered action. 

Procedure 

1.  Select the action to delete from the [Action Settings Dialog]. 

After selecting, click [Delete]. 

 

 

 

2.  Selected action will be deleted. After deleting, click [OK]. 

 

 

 

 

 
  



11. Action Settings  

InfoSOSA Builder Operation Manual 187 

11.1.5 Edit Action  

Edit and re-set a registered action. 

Procedure 

1.  Select the action to edit from the [Action Settings Dialog]. 

After selection, click [Edit]. 

 

 

 

 

2.  The [Action Update Dialog] is displayed.     
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3.  Set action again, and click [OK]. 

  

 
4.  The new Action setting after the edit is displayed. 

Click [OK]. 
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Action to execute 

11.1.6 Set Action Blocks 

Set the action block. 

Action block is used when setting IF statements, FOR statements and WHILE statement. 

The Configuration of the Action Block 

Action block consists of actions that are the conditional statement and actions that are actually 

performed. 

First, in each block, for the conditional expression set an action from the [Execution Control] 

action group. 

After setting, add the action to actually execute to the action block. 

Action Block Configuration Screen 

 

Action Block Structure 

 

  

Action Block 

Action of the conditional expression 
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Setting of Conditional Expression (Action) 

Set the action that will be the conditional expression. 

In the same way as normal action settings, set from the [Add Action Dialog]. 

Procedure 

1.  From the [Action Settings Dialog] [Event] menu, select the action that will run the event. 

After selecting, click [Add]. 

 

 

 

 

2.  The [Add Action Dialog] is displayed. 
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3.  From the [Action Group] menu, select [Control Statements]. 

 

 

4.  From the [Action] menu, select the action block of the condition you want to set. 

  

 

5.  Set each parameter. 

When all the settings are complete, click [OK]. 

  

Select from each block 

Select Control Statements 
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6.  Contents of the conditional expression's action settings are added to the [Action Settings 

Dialog]. 

Click [OK]. 
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Adding Action to Action Block 

Add action to actually perform to the action block with the conditional expression. 

Procedure 

1.  Select the action block you want to add the action to in the [Action Settings Dialog]. 

After selecting, click [Add To Block]. 

 

 

 

2.  The [Add Action Dialog] is displayed. 

Run action settings and click [OK]. 
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3.  New action is added to the action block. 

Click [OK]. 
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11.1.7 Copy Action Blocks 

You can copy the action to the action block. 

The entire action block can also be copied in the same way as the normal action. 

Copy to Action Block 

Add the action that you copied to the action block. 

Procedure 

1.  Select the action you want to copy in the [Action Settings Dialog]. 

After selecting, click [Copy]. 

 

 

 
2.  Select the action block you want to paste with the action, and click [Paste To Block]. 
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3.  Copied action is added in the specified block. 

Click [OK]. 

 

 

 

  

◆ From Ver. 2.7, it is now possible to paste a copied action to 

another part. 
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Copy Action Block 

The entire action block can be copied in the same way as the normal action. 

Procedure 

1.  Select the action block you want to copy in the [Action Settings Dialog]. 

After selecting, click [Copy]. 

 

 

2.  Click [Paste]. 

 

  

◆ From Ver. 2.7, it is now possible to paste a copied action to 

another part. 
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3.  Copied action block is added. 

Click [OK]. 

 

 

 

11.1.8 Delete and Edit of Action Blocks 

Delete or edit the action block in the same way as normal actions with the [Delete] and [Edit] 

buttons. 
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11.2 Subroutines 

 

You can register the action that is frequently used as subroutine. 

You can use a subroutine as the action for a [Subroutine Call]. 

* For more information about each item, please refer to the "Reference Manual". 

11.2.1 Subroutine Screen 

The subroutine screen appears when you select the editor display area's [Subroutine] tab. 

You can register and edit from the subroutine screen. 

 

  

Select [Subroutine] tab 
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11.2.2 Register subroutine 

Register subroutine. 

Procedure 

1.  From the [Subroutine Screen] click [Add]. 

 

 

2.  The subroutine [Action Settings Dialog] is displayed.  

Enter the [Subroutine ID], [Target Screen Of Subroutine], and [Comment]. 

 

 

No Item Contents 

①  ID Use with [Subroutine Call] actions, and when using Host 
Communication to select a subroutine. 

②  Target Screen Of Subroutine Possible to call subroutine from all screens. 
Therefore, only Global Memory is available for parameters of 
action. 
 
However, when target screen is set, you will be able to use target 
screen Parts and Screen Memory. 
* If you specify an execution target screen, you can run the 
subroutine from that screen only. 

③  Comment Input can be omitted. 

 

  

① ② 

③ 



11. Action Settings  

InfoSOSA Builder Operation Manual 201 

 

3.  The rest of the Action settings procedures are the same as the normal Action settings. 

 

4.  Subroutine will be registered to the subroutine screen if you set the action. 

 

 

11.2.3 Edit Subroutine 

Edit the registered subroutine. 

Procedure 

1.  Select the subroutine to edit from [Subroutine Screen]. 

After selection, click [Edit]. 

 

 

2.  [Action Settings Dialog] for the subroutine is displayed. 

Edit subroutine ID and comments and/or add actions and click [OK]. 

Adding or editing of Action is the same process as a normal Action setting. 
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11.2.4 Copy Subroutine 

Copy the registered subroutine. 

Procedure 

1.  From the [Subroutine Screen], select the subroutine to copy. 

After selecting, click [Copy] and [Paste]. 

 

 

 

2.  Subroutine that you copied to the list of subroutine screen will be registered. 

 

 

 

 

 

 

  

◆ You can copy multiple subroutines at once by holding down the 

Shift key (or Ctrl key) while selecting them. * Ver. 2.7 or later 
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11.2.5 Delete Subroutine 

Delete the registered subroutine. 

Procedure 

1.  From the [Subroutine Screen], select the subroutine to delete. 

After selecting, click [Delete]. 

 

 

2.  Selected subroutine will be deleted. 
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11.2.6 Sorted display of Subroutine 

This function makes it easier to find the desired subroutine by sorting it by the specified item. 

*Ver. 2.7 or later 

 

Procedure 

Click the header of the column you want to use as the basis. 

Each time you click on the column header, the order changes from descending to ascending to 

cancel. 

 

  

 

 

 

ID sort 

  

 

 

Comment sort 

  

 

 

 

 

 
 

 

 

 

 

 

Click here 

 

Click here 

 

◆ The sorted display is temporary. When the project is opened, it will 

be in a canceled state. 
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12. Sheet Key Setting 

 

 

 

Chapter Contents 

12.1  Sheet Key Setting.................................................................................... 206 

12.2  LED Settings ........................................................................................... 207 

12.3  SW Setting .............................................................................................. 208 
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12.1 Sheet Key Setting 

 

You can setup the Sheet Key Switch and the LED. 

* Only applies to sheet key compatible models. 

* Sheet key is optional. 

12.1.1 Sheet Key Setting Screen 

In the drawing area, select the [Sheet Key Setting] tab and the Sheet Key setting screen 

appears. 

In the Sheet Key Setting screen there are [LED Setting] and [SW Setting] screens. 

 

 

Select Sheet Key Setting 

Select either [LED Setting] or [SW Setting]. 
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12.2 LED Settings 

 

Set the sheet key LED. 

If [LED] is enabled (blank), you can select it for [LED output] actions. 

* For more information, please refer to the "Reference Manual". 

12.2.1 LED Setting Screen 

LED Setting screen is displayed when in the Sheet Key Setting screen you select the [LED 

Setting] tab. 

 

12.2.2 LED Settings 

Set the presence or absence of the sheet key LED. 

Procedure 

1.  In the LED Setting screen, from the [LED] menu for the LED to set up, select either [Blank 

(Yes)] or [X (No)]. 

 

 

* You an edit the [LED Name] by direct input. 

Blank ... Yes 
X     ... No 
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12.3 SW Setting 

 

Property setting and Action settings of the sheet key switch. 

* For more information, please refer to the "Reference Manual". 

12.3.1 SW setting screen 

SW Setting screen is displayed when in the Sheet Key Setting screen you select the [SW 

Setting] tab. 

 

SW setting screen 

 

 

 

No Item Contents 

①  No. Switch number. Cannot be edited. 

②  SWID This is the switch ID. Cannot be edited. 

③  SW Name Set name of switch. Edit from list and [Advanced Properties Dialog]. 

④  SW Set [Yes]/[No] of switch. 
Set [blank (Yes)] or [X (No)]. 

⑤  Input Method [Operation SW input] is fixed. 

 

⑤ ④ ③ ② ① 
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12.3.2 Edit Switch (Property Screen Display) 

Set the switch property. 

Procedure 

1.  From the [SW Setting] screen, select the switch with the properties to set up. 

After selecting, click [Property]. 

 

 

 
2.  The switch's [Advanced Properties Dialog] is displayed. 

Select and edit each item. 

 

* For more information about each item, please refer to the "Reference Manual". 
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12.3.3 Switch Action Settings 

Set the switch action. 

Procedure 

1.  From the [SW Setting] screen, select the switch with the properties to set up. 

After selecting, click [Property]. 

 

 

 
2.  The switch's [Advanced Properties Dialog] is displayed. 

Action can be set for each screen. 

After selecting the screen ID, press the [Action Settings] button. 

 

* By using [Copy To Screen] or [Copy To All Screens], you can make a copy of the action to 

other screens. 

 
3.  The rest of action setting is the same procedure as the Action Setting of the Parts. 

 



12. Sheet Key Setting  

InfoSOSA Builder Operation Manual 211 

12.3.4 Copy Other Switches 

Copy in batch the property setting and the action setting to other switches. 

Procedure 

1.  From the [SW Setting] screen, select the switch to copy and click the [Copy Of Properties 

And Actions] button. 

  

 

 

2.  The [Copy Of Sheet Key Setting And Action (Switch To Switch)] is displayed. 

Select the destination of the action setting, and click [Copy]. 

 

 
3.  In the confirmation dialog box click [Yes]. 

 

 
4.  Property setting and action setting is copied to the selected switch. 
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13. System Settings 

 

 

 

Chapter Contents 

13.1  H/W Setting ............................................................................................. 213 

13.2  Communication Settings (Target) (IS) ..................................................... 220 

13.3  Communication Settings (Target) (IS-APP) ............................................. 224 

13.4  System Font Settings .............................................................................. 230 

13.5  Standard Color Setting ............................................................................ 233 

13.6  Image Font Registration .......................................................................... 235 
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13.1 H/W Setting 

 

In [H/W Setting], you can change the model, default brightness, as well as other settings. 

Setting Procedure 

1.  From the [System Settings] menu, select [H/W Settings]. 

[H/W Settings Dialog] is displayed. 

 

 
 

2.  Set each item and click [OK]. 

 

  

  

⑨ 

⑧ 

⑦ 

⑥ 

⑤ 

④ 

③ 

① 

② 

⑩ 
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Setting Item (IS) 

No Item Contents 

①  Select Product Select the InfoSOSA model name. 
Select Series Name, Rep. Model (representative models), No. of Colors 
(Number of colors), and MultiLingual (Multi-language support), then 
choose a model name from the right pane. For the model name and 

product models listed in InfoSOSA Builder, refer to 17.1 Corresponding 

Model List. 

②  Resolution LCD resolution of model 

③  No. Of Colors Number of LCD color of model 

④  Auto Off Set auto-off time of backlight. Default setting is [NO]. 

⑤  Brightness Set brightness of backlight. 
For the brightness, select from 1 to 8. 
1 is darkest, 8 is brightest. 
Default setting is 4. 

⑥  Rotation Angle Set rotation angle of screen. 
Select 0°, 90°, 180°, or 270°. 
Default setting is 0°. 

⑦  Screen After Startup Set base screen to be displayed first after starting InfoSOSA. 
Default setting is the first screen created in Builder: "BAS00001". 

⑧  Control Character Input Set [Yes] to enable control character input. 
Default is [No]. 
Use to output control characters for action [Output string of memory to 
Host]. 

⑨  Default Sound Set operation sound of Parts that can be touch input.  
Target is new Parts placed from toolbox.  
Operation sounds of Parts already placed will not change. Operation 
sounds of already placed Parts can be set by properties of Parts. 
For operation sounds, you can select [None], or patterns 1 to 9. Pitch 
pattern 1 is lowest, pattern 9 is highest.  
Default is [Pattern 6]. 

⑩  User Version Any version can be set. You can set versions etc. of created project.  
Value set can be obtained with Host communication.  
Up to 16 alphanumeric characters can be input.  
Symbols you can use are [.(period)], [- (hyphen)], and [_ (underscore)]. 
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Setting Item (IS-APP) 

No Item Contents 

①  Select Product Select the InfoSOSA model name. 
Select Series Name and Rep. Model (representative model), then choose 
a model name from the right pane. 
For the model name and product models listed in InfoSOSA Builder, refer 
to 17.1 Corresponding Model List. 

②  Screen After Startup Set base screen to be displayed first after starting InfoSOSA. 
Default setting is the first screen created in Builder: "BAS00001". 

③  Control Character Input Set [Yes] to enable control character input. 
Default is [No]. 
Use to output control characters for action [Output string of memory to 
Host]. 

④  Default Screen Size Standard size of Base/Pop-up Screens. Newly created screens will be 
this size. As IS-APP does not have any special hardware, set up to match 
the run environment. 

⑤  Default Sound Set operation sound of Parts that can be touch input.  
Target is new Parts placed from toolbox.  
Operation sounds of Parts already placed will not change. Operation 
sounds of already placed Parts can be set by properties of Parts. 
For operation sounds, you can select [None], or patterns 1 to 9. Pitch 
pattern 1 is lowest, pattern 9 is highest.  
Default is [Pattern 6]. 

⑥  User Version Any version can be set. You can set versions etc. of created project.  
Value set can be obtained with Host communication.  
Up to 16 alphanumeric characters can be input.  
Symbols you can use are [.(period)], [- (hyphen)], and [_ (underscore)]. 

⑥ 

⑤ 

④ 

③ 

① 

② 
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Change Model 

 

In "① Select Product", you can change the model set for the project. 

For supported products and models, please refer to 17.1 Corresponding Model List. 

If the screen size changes, you can select whether to resize the parts and their positions. 

  

 
 

No Item Contents 

①  Change Size Displays the previous resolution and new resolution. 
For IS-APP: Displays the default screen size. 

②  Base Screen Resize 
Option 

Set resizing the Base Screen to either on or off. 
 

③  Popup Screen Resize 
Option 

Set resizing the Popup Screen to either on or off. 
 

 
 
  

② 

③ 

① 
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Adjust the screen size and parts size to match the screen size 

Resizes the screen size and parts size. 

 

    
 
 

Adjust the screen size to match the screen size, but do not change parts size 

Resizes the screen size. 
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◆ Please note that the following dialog box settings are initialized 

when the model is changed. 
- H/W Settings Dialog 
- Communication Settings (of Target) Dialog 

 

◆ The parts horizontal and vertical positions, and width and height 

will change, but the other properties do not. For changes to font size 
and so on, edit after changing the model. 

 

Do not change the screen size or parts size 

There is no resizing. 

* You can select this option only when changing to IS-APP. 
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Information on each item 

 

Rotation Angle 

Screen display when specified in the rotation angle, becomes as follows. 

Both origin coordinates on the screen will be the upper left corner. 

 

           

 
 

           
 

 

 

 

 

90° 

(0,0) 

270° 

0° (0,0) 

(0,0) 

180° 
(0,0) 
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13.2 Communication Settings (Target) (IS) 

 

If the selected project is for the IS7 series, the settings in this dialog box after download are the 

communication settings of InfoSOSA and host (such as microcontroller board). 

 

Setting Procedure 

1.  From the [System Settings] menu, select [Communication Settings (Target)]. 

[Communication Settings (Target) Dialog] is displayed. 

 

 

 

2.  Configure each port (SIO1 and SIO2) and the common settings and click [OK]. 

13.2.1 SIO1 Communication Setting 

In [Communication Settings (Target) Dialog] click the [SIO1] tab and set each item. 

       

  

⑧ 

⑦ 

⑥ 

⑤ 
④ 

③ 
② 

① 
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No Item Contents 

①  Communication 
Protocol 

Set up the function to associate with the SIO1 port. 
Set [Not Used] and [Host]. 
If you want to use the SIO1 port, set [Host]. 

②  Communication Mode Set up the SIO1 port [Host] and [Communication Mode]. 
Select [InfoSOSA Protocol] from [Normal Protocol].  
- InfoSOSA Protocol: Mode that responds only to acquisition commands 
from host. It does not respond to set commands.  
- Normal Protocol: Mode that respond to all set and acquisition 
commands from Host. 

③  Device Communication interface is displayed. 
Fixed to [RS232]. 

④  Communication Speed Set communication speed. 
Select from 4800, 9600, 19200, 38400, 57600, or 115200 bps. 

⑤  Character Bit Displays the character bits. Fixed to 8 bits. 

⑥  Stop Bit Stop bit is displayed. Fixed to 1. 

⑦  Parity Bit Set parity bit. Select from [None], [Even] or [Odd]. 

⑧  Flow Control Set H/W flow control. 
Set [Yes] or [No]. 
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13.2.2 SIO2 Communication Settings 

In [Communication Settings (Target) Dialog] click the [SIO2] tab and set each item. 

  

 

No Item Contents 

①  Communication 
Protocol 

Set up the function to associate with the SIO2 port. 
Set [Not Used] and [Host]. 
If you want to use the SIO2 port, set [Host]. 

②  Communication Mode Set up the SIO2 port [Host] and [Communication Mode]. 
Select [InfoSOSA Protocol] from [Normal Protocol].  
- InfoSOSA Protocol: Mode that responds only to acquisition commands 
from host. It does not respond to set commands.  
- Normal Protocol: Mode that respond to all set and acquisition 
commands from Host. 

③  Device Communication interface set will be displayed. 
Fixed to [RS422 (Full Duplex) / 485 (Half Duplex)]. 
* Toggle between RS422/485 with the hardware switch on the board. For 
more information, please refer to the manufacturer specifications. 

④  Communication Speed Set communication speed. 
Select from 4800, 9600, 19200, 38400, 57600, or 115200 bps. 

⑤  Character Bit Displays the character bits. Fixed to 8. 

⑥  Stop Bit Stop bit is displayed. Fixed to 1. 

⑦  Parity Bit Set parity bit. Select from [None], [Even] or [Odd]. 

⑧  Address Device address assigned at time of RS485 communication. 
Select from 1 to 31. You cannot set "0" as it indicates Host. The device is 
enabled for [RS485], and fixed to 0 for [RS422]. 

⑨  Re-Send Count Set number of times to resend send message to Host from InfoSOSA 
when line collisions occur at RS485 communication. 
Set from 0 to 10. Default value is 3. 

⑩  Re-Send Interval Set resend interval at RS485 communication. 
Set from 0 to 1000. Default value is 100. 
Each unit is 10ms.  
* The interval changes depending on the communication speed as it 
becomes the standby time after communication is complete. 

 
  

⑥ 

⑤ 
④ 

③ 
② 

① 

⑦ 

⑧ 

⑨ 
⑩ 
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13.2.3 Setting of Communication by Action 

From the [Communication Settings (Target) Dialog] click the [Communication by Action] tab and 

set each item. 

Set output destination of events generated and event retransmission of InfoSOSA. 

  

 

No Item Contents 

①  Notify Event to Host Set up the interface for sending commands when [Notify Event to Host] 
and [Notify value to Host] actions are processed. 
In the SIO1 or SIO2 [Setting] tab, set [Communication Protocol] to [Host]. 
You can select one of these interfaces. 
When set to [No Communication], events are not output to any interface. 

②  Notification Method Set event notification methods. 
Select either [Immediate Notification] or [Upon Request]. 
- Immediate Notification: Send event to Host immediately with action 
execution. 

・ Upon Request: Do not send event until you receive [Acquire Event] 

command from Host. 
* Up to a maximum of 10 events can be accumulated in InfoSOSA. 
 If event is full, it will be erased from older events. 

③  Send String to Host Set interface to output string when action [Output string of memory to 
Host] is processed. 
In the SIO1 or SIO2 [Setting] tab, set [Communication Protocol] to [Host]. 
You can select one of these interfaces. When set to [No Communication], 
events are not output to any interface. 

④  Respond Monitoring Time When event is noticed to host device, set time-out period. Set a value 
from 1 to 5. (The unit is in seconds.) 
Enabled when [Communication Mode] is [Normal Protocol]. 

⑤  Retry Count When event response has timed out, set number of times to be 
retransmitted. 
Set a value from 0 to 3. (The unit is times.) 
Enabled when [Communication Mode] is [Normal Protocol]. 

 

 

 

③ 

⑤ 

④ ① 

② 
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13.3 Communication Settings (Target) (IS-APP) 

 

If the selected project is for IS-APP, the settings in this dialog box are used only for simulation. 

The actual communication settings are run with command line arguments used when starting the 

InfoSOSA application. For more information, please refer to the "IS-APP Startup Guide". 

 

Setting Procedure 

1.  From the [System Settings] menu, select [Communication Settings (Target)]. 

[Communication Settings (Target) Dialog] is displayed. 

 

 

 

 

2.  Set communication settings of common items and each port (SIO1, SIO2, LAN) and click 

[OK]. 
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13.3.1 SIO1 Communication Setting 

In [Communication Settings (Target) Dialog] click the [SIO1] tab and set each item. 

       

No Item Contents 

①  Communication 
Protocol 

Set up the function to associate with the SIO1 port. 
Set [Not Used] and [Host]. 
If you want to use the SIO1 port, set [Host]. 

②  Communication Mode Set up the SIO1 port [Host] and [Communication Mode]. 
Select [InfoSOSA Protocol] from [Normal Protocol].  
- InfoSOSA Protocol: Mode that responds only to acquisition commands 
from host. It does not respond to set commands.  
- Normal Protocol: Mode that respond to all set and acquisition 
commands from Host. 

③  Device Communication interface is displayed. 
Fixed to [RS232]. 
* At simulation, communication is RS232 only. 

④  Communication Speed Set communication speed. 
Select from 4800, 9600, 19200, 38400, 57600, or 115200 bps. 

⑤  Character Bit Displays the character bits. Fixed to 8. 

⑥  Stop Bit Stop bit is displayed. Fixed to 1. 

⑦  Parity Bit Set parity bit. Select from [None], [Even] or [Odd]. 

⑧  Flow Control Set H/W flow control. 
Set [Yes] or [No]. 

 
  

⑧ 

⑦ 

⑥ 

⑤ 
④ 

③ 
② 

① 
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13.3.2 SIO2 Communication Settings 

In [Communication Settings (Target) Dialog] click the [SIO2] tab and set each item. 

 

 

No Item Contents 

①  Communication 
Protocol 

Set up the function to associate with the SIO2 port. 
Set [Not Used] and [Host]. 
If you want to use the SIO2 port, set [Host]. 

②  Communication Mode Set up the SIO2 port [Host] and [Communication Mode]. 
Select [InfoSOSA Protocol] from [Normal Protocol].  
- InfoSOSA Protocol: Mode that responds only to acquisition commands 
from host. It does not respond to set commands.  
- Normal Protocol: Mode that respond to all set and acquisition 
commands from Host. 

③  Device Communication interface is displayed. 
Fixed to [RS232]. 
* At simulation, communication is RS232 only. 

④  Communication Speed Set communication speed. 
Select from 4800, 9600, 19200, 38400, 57600, or 115200 bps. 

⑤  Character Bit Displays the character bits. Fixed to 8. 

⑥  Stop Bit Stop bit is displayed. Fixed to 1. 

⑦  Parity Bit Set parity bit. Select from [None], [Even] or [Odd]. 

⑧  Flow Control Set H/W flow control. 
Set [Yes] or [No]. 

 
  

⑥ 

⑤ 
④ 

③ 
② 

① 

⑦ 
⑧ 
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13.3.3 Communication Settings of LAN (TCP Client) 

In [Communication Settings (Target) Dialog], click first the [LAN] and then [TCP Client] tabs to 

set each item. 

 

 

No Item Contents 

①  Communication 
Protocol 

Set up the function to associate with the LAN port. 
Set [Not Used] and [Host]. 
If you want to use the LAN port, set [Host]. 

②  Communication Mode Set up the LAN port [Host] and [Communication Mode]. 
Select [InfoSOSA Protocol] from [Normal Protocol].  
- InfoSOSA Protocol: Mode that responds only to acquisition commands 
from host. It does not respond to set commands.  
- Normal Protocol: Mode that respond to all set and acquisition 
commands from Host. 

③  Host IP Address Set IP address of host device to communicate with InfoSOSA. 
Set "0.0.0.0" if not in use. 

④  Host Port Set port number of host device to communicate with InfoSOSA. 
Set a value for the port, from 1024 to 65535. 
Port numbers 51110, 51111 and 51112 are reserved and cannot be used. 

⑤  Connection Time Set trial time of TCP connection. 
Set a value from 0 to 99. (The unit is in seconds.) 

 
  

① 

 

⑤ ④ ③ 

② 
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13.3.4 Communication Settings of LAN (UDP Client) 

In [Communication Settings (Target) Dialog], click first the [LAN] and then [UDP Client] tabs to 

set each item. 

 

 

No Item Contents 

①  Communication 
Protocol 

Set up the function to associate with the LAN port. 
Set [Not Used] and [Host]. 
If you want to use the LAN port, set [Host]. 

②  Communication Mode Set up the LAN port [Host] and [Communication Mode]. 
Select [InfoSOSA Protocol] from [Normal Protocol].  
- InfoSOSA Protocol: Mode that responds only to acquisition commands 
from host. It does not respond to set commands.  
- Normal Protocol: Mode that respond to all set and acquisition 
commands from Host. 

③  Host IP Address Set IP address of host device to communicate with InfoSOSA. 
Set "0.0.0.0" if not in use. 

④  Host Port Set port number of host device to communicate with InfoSOSA. 
Set a value for the port, from 1024 to 65535. 
Port numbers 51110, 51111 and 51112 are reserved and cannot be used. 

 

  

③ ④ 

①  

② 
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13.3.5 Set Communication by Action 

From the [Communication Settings (Target) Dialog] click the [Communication by Action Setting] 

tab and set each item. 

Set output destination of events generated and event retransmission of InfoSOSA. 

 

No Item Contents 

①  Notify Event to Host Set up the interface for sending commands when [Notify Event to Host] 
and [Notify value to Host] actions are processed. 
In the SIO1, SIO2, or LAN [Setting] tab, set [Communication Protocol] to 
[Host]. You can select one of these interfaces. 
When set to [No Communication], events are not output to any interface. 

②  Notification Method Set event notification methods. 
Select either [Immediate Notification] or [Upon Request]. 
- Immediate Notification: Send event to Host immediately with action 
execution. 
- Upon Request: Do not send event until you receive [Acquire Event] 
command from Host. 
* Up to a maximum of 10 events can be accumulated in InfoSOSA. 
 If event is full, it will be erased from older events. 

③  Send String to Host Set interface to output string when action [Output string of memory to 
Host] is processed. 
In the SIO1 or SIO2 [Setting] tab, set [Communication Protocol] to [Host]. 
You can select one of these interfaces. * Cannot output to LAN. 
When set to [No Communication], events are not output to any interface. 

④  Respond Monitoring Time When event is noticed to host device, set time-out period. Set a value 
from 1 to 5. (The unit is in seconds.) 
Enabled when [Communication Mode] is [Normal Protocol]. 

⑤  Retry Count When event response has timed out, set number of times to be 
retransmitted. 
Set a value from 0 to 3. (The unit is times.) 
Enabled when [Communication Mode] is [Normal Protocol]. 

 

③ 

⑤ 
④ ① 

② 



13. System Settings  

InfoSOSA Builder Operation Manual 230 

13.4 System Font Settings 

 

In the [System Font Settings], select the type of system fonts to use. 

Setting Procedure 

1.  From the [System Settings] menu, select [System Font Settings]. 

[System Font Selection Dialog] is displayed. 

 

 

2.  Set each item and click [OK]. 

Setting Item 

 

No Item Contents 

①  Font  Select font to be used. 
Fonts that can be used in InfoSOSA are as follows. 
- Gothic BOLD (Japanese) 
- Gothic NORMAL (Japanese) 
- Simplified Gothic (Chinese) 
- Traditional Gothic (Chinese) 
- Hangul Gothic (Korean) 
- Latin Gothic (European) 
* English letter is included in all fonts. 
* Japanese "BOLD" is bold, and "NORMAL" is fine print. 
* File size of Font vary depending on language. Depending on project, 

you may not be able to download a screen to InfoSOSA if you change 
the language. 

* Font that is displayed depends on model. 

 

① 
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Languages that are Supported by Each Font 

Font name Character 

encoding 

standard 

Languages 

Gothic 
BOLD/NORMAL 

JIS-X0201 Japanese (alphanumeric) 

JIS-X0208 Japanese (Hiragana, Katakana, Kanji) 

Traditional Gothic Big5 Chinese (Traditional) 

Simplified Gothic GB18030 Chinese (simplified) 

Hangul Gothic KSC-5601 Korean (Hangul) 

Latin Gothic 

ISO8859-1 
(Latin-1) 

English, French, Spanish, German, Italian, 
Portuguese, Indonesian, Swedish, 
Dutch, Danish, Norwegian, 
Finnish, Icelandic, and Faroese 

ISO8859-2 
(Latin-2) 

Croatian, Czaech, Hungarin, Polish, 
Romanian, Slovakian, Slovenian, and Sorbian 

ISO8859-3 
(Latin-3) 

Esperanto, Maltese, Turkish (Old) 

ISO8859-4 
(Latin-4) 

Estonian, Latvian, Lithuanian 

ISO8859-5 Bulgarian, Macedonian, Russian, Serbian, and 
Ukrainian 

ISO8859-7 Modern Greek 

ISO8859-9 
(Latin-5) 

Turkish (new) 

 

Usage Restrictions of Fonts 

InfoSOSA has different fonts available depending on the model. 
Depending on the fonts you can use on your model, there are two types of fonts – 
[Standard] and [Multilingual] . 
 
* For the relationship between the model and fonts, please refer to 17.1 Corresponding Model 

List. 

 

Font name Standard Model Multilingual Model 

Gothic BOLD/NORMAL ○ ○ 

Traditional Gothic × ○ 

Simplified Gothic × ○ 

Hangul Gothic ○ ○ 

Latin Gothic ○ ○ 

Number of fonts that can be used 
simultaneously 

1 5 

 
 

  



13. System Settings  

InfoSOSA Builder Operation Manual 232 

Display Priority of Each Font 

InfoSOSA uses the character code of the UNICODE (UTF-16LE). 
On InfoSOSA, appropriate characters are displayed using the downloaded font and 
character encoding. 
With UNICODE (UTF-16LE), since multiple characters are assigned to one character code, 
the font that is used is decided based on the following. 
 

1) A text string is displayed using one font. 
2) If the text string can be displayed with European text (ISO8859) and the Latin Gothic 

font is downloaded, it is displayed in Latin Gothic. 
3) Characters are determined in the following order of preference: Gothic (Japanese) > 

Traditional Chinese Gothic > Simplified Chinese Gothic > Hangul Gothic > Latin Gothic. 
 
 

As the font is automatically determined as shown above, you do not have to specify a font. 
However, if you want to display using a specific font, set the [String Resource Set ID] to 
[Define Font String Resource Set ID]. 

 

[Define Font String Resource Set ID] 

Define Font String Resource Set ID Preferred Font 

@JA, @JA_1 to @JA_9 Gothic 
BOLD/NORMAL 

(Japanese) 

@ZHBIG, @ZHBIG_1 to @ZHBIG_9 Traditional Gothic 
(Chinese) 

@ZHGB, @ZHGB_1 to @ZHGB_9 Simplified Gothic 
(Chinese) 

@KR, @KR_1 to @KR_9 Hangul Gothic 
(Korean) 

@EN, @EN_1 to @EN_9 Latin Gothic 
(Europe) 

* When the preferred font is not downloaded, the font is determined using the 
normal method. 

 

To create multiple sets in String Resources with the same font, as shown below specify a 

String Resource Set ID for different languages. 

For example, when changing between German and French which both use the same 

Latin Gothic font 

String Resource Set ID Language 

@EN_1 German 

@EN_2 French 

* You can register a maximum 10 String Resource sets. 
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13.5 Standard Color Setting 

 

Image editing software to be used in the InfoSOSA Builder and color arrangement of the color 

palette to use for part background and characters can be set in the Standard Color Setting. 

The settings will be saved in the project. 

Setting Procedure 

1.  From the [System Settings] menu, select [Standard Color Setting]. 

[Standard Color Setting Dialog] is displayed. 

 

 

2.  Set each item and click [OK]. 

Setting Item 

 

 

No Item Contents 

①  Select Image Editing 
Software 

Set image editing software to be used in editing of image resource. 
Click [Browse] to select image editing software. 
Default setting is MS Paint. 

② 

① 
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No Item Contents 

②  Standard Color Set colors and their arrangement on the color palette. 
Color palette will be displayed when changing the background color, 
character color, and other colors of Parts. 
To select a new color, click on the desired color to change. 
Click the [Clear] button to return to the default colors. 
* Depending on the color and model you set, the number of colors may 
be reduced. 
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13.6 Image Font Registration 

 

Register specific characters in any of image fonts. 

Image Font Registration is needed when there is a string change from the Host, or when 

displaying fonts as image fonts to a particular part that are not pre-set. 

 

Setting Procedure 

1.  From the [System Settings] menu, select [Image Font Registration]. 

[Image Font Registration Dialog] is displayed. 

 

 

2.  Set each item and click [OK]. 

 

Setting Item 

 

  

③ ② ① 

④ ⑤ ⑥ ⑦ 
⑧ ⑨ 
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No. Item Contents 

① Character Font Set type of image fonts. 
Match image font to character font of Parts to display. 
Fonts that can be selected will vary depending on computer 

② Size Set size of image font. 
Match image font to character size of Parts to display. 
Configurable size is 8pt to 256pt. 

③ String Set character to be registered. 
It can be set up to a maximum of 256 characters. 

④ Sorting Sort registered image fonts. 

⑤ Add Add new image fonts. 

⑥ Copy Copy registered image fonts. 

⑦ Delete Delete registered image fonts. 

⑧ OK Reflect settings and close dialog. 

⑨ Cancel Discard settings and close dialog. 

* Image fonts will not display correctly if the image fonts and font size do not match with the Parts. 

* Characters are registered in the image font one character at a time. For example, when displaying the 

string "Seedsware" with image fonts, it displays even when registered as "Sedswar". 
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14. Download 
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14.1 About Download 
In the [Download] menu, [Create Data] is for converting editable project data into executable files 

for the InfoSOSA unit, and [Download] is for transferring the project you created to the InfoSOSA 

unit. 

 

 

 

 

 

 

 

Create Data 

 

Item Contents IS7 IS-APP 

Create Data 
(USB/IS-APP) 

Converts editable project data into executable files for 
the InfoSOSA unit. Use with USB Download and 
IS-APP. 

○ ○ 

Create Data (SIO) Ver 2.1 compatible format. Cannot be used with 
IS-APP. 

○ - 

 

Download 

 

The following download methods are available. 

How to Download Features IS7 IS-APP 

USB ・ New method from Ver 2.5. 

・ Faster download speeds than Ver 2.1. 

・ Simultaneous download to multiple units. 

・ Possible to back up project on unit. 

・ Possible to transfer the currently open project. 

・ You can transfer [Saved Project Data] (compiled 

data) 

・ Updates the project runtime application. 

○ - 

SIO ・ Ver 2.1 compatible format. 

・ Same download speed as Ver 2.1. 

・ Download one unit at a time. 

・ Project backup not possible 

・ Possible to transfer the currently open project. 

・ You cannot transfer [Saved Project Data] 

(compiled data) 

・Updates the project runtime application.* 

* In the case of Ver 2.5, no update on the project 
runtime application. 

○ - 

 

◆ Perform an “Error check” before “Create Data” or ”Download”. For 

details, refer to "14.6 Error check". 
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IS-APP does not support download. For transfer methods of created executable files, please 

refer to the "IS-APP Startup Guide". 
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14.2 Create Data (USB/IS-APP) 

 

Create Data is a function that creates or compiles data for USB download (for execution on 

InfoSOSA), without actually downloading. 

 

The created data has the following uses. 

◆ Download (USB) - Saved Project Data 

Please refer to 14.1 About Download for usage. 

 

◆ Download data when using [Download Tool (USB)] 

For information about [Download Tool (USB)], please refer to the "IS731 Series Startup 

Guide". 

 

◆ InfoSOSA Application (IS-APP) executable files 

Please refer to the "IS-APP Startup Guide" for usage. 

 

 

Data Creation Procedure 

 

1.  Open the project for which you want to create data. 

 

 

2.  From the [Download] menu, select [Create Data(USB/IS-APP)]. 
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3.  [Data Creation Dialog] is displayed. 

Click [Browse] and you can change the save destination. 

Click [Create]. 

 

 

No Item Contents 

①  Download Data Displays information on the data to create. 

②  Saving Destination Displays the save destination for created data. Click [Browse] and select 
a folder. 

③  Open data folder after 
saving 

Select the check box to open the destination folder after the create data 
operation. 

 

 

When create data is complete, the following message is displayed. 

 

 

 

 

  

① 

② 

③ 
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Data structure 

The download data (executable files for InfoSOSA) generated with [Create Data] is structured as 

follows. All files are necessary for download, so save all folders. 

* If you do not want to do a project backup, you do not need the "project" folder. 

 

 

Project Name: Project1 

User Version: 1.0.0 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Item Contents 

Project1_1.0.0 Save all data below this folder. 

data Folder where the compiled project data (executable files for InfoSOSA) is 
stored. 

project Folder where the editable project data is stored. 

Project1_1.0.0.ipp When the [Backup Project to Unit] check box is selected, this file is 
downloaded. 

is7runtime.bin This is an application for running project data. 
This is downloaded with the project data. 
* Different filename depending on the model. 

Project1_1.0.0.IScpi System file that describes the download data structure. 
When downloading, specify this file. 

 

 

 

 

  

Project1_1.0.0 data 

project 

is7runtime.bin 

Project1_1.0.0.IScpi 

Project1_1.0.0.ipp 
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14.3 Create Data (SIO) 

 

Create Data (SIO) is a function that creates or compiles data for SIO/LAN download (for 

execution on InfoSOSA), without actually downloading. 

 

This function is compatible with InfoSOSA Ver 2.1. 

The Download Tool (SIO) is not provided in Ver 2.5 or later. 

Use [Create Data (USB/IS-APP)] and the Download Tool (USB). 

 

 

Data Creation Procedure 

 

1.  Open the project for which you want to create data. 

 

 

2.  From the [Download] menu, select [Create Data (SIO)]. 

 

 

3.  [Data Creation Dialog] is displayed. 

Click [Browse] and you can change the save destination. 

Click [Save]. 

 

  

① 

② 

③ 
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No Item Contents 

①  Download Data Displays information on the data to create. 

②  Saving Destination Displays the save destination for created data. Click [Browse] and select 
a folder. 

③  Open data folder after 
saving 

Select the check box to open the destination folder after the create data 
operation. 

 

When create data is complete, the following message is displayed. 

 

 

 

Data structure 

The data for download (for execution on InfoSOSA) created in "Data creation" has the following 

structure. All files are required for download, so please keep them in the folder. 

 

Project Name: Project1 

User Version: 1.0.0 

 

 

 

 

 

 

 

 

 

 

Item Contents 

Project1_1.0.0 Save all data below this folder. 

Firmware 
 

A folder containing applications for executing project data. Downloaded 
with project data. 

Project1_1.0.0.isp Converted project data for execution in InfoSOSA. 

 

 

 

Project1_1.0.0 Firmware 

Project1_1.0.0.isp 
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14.4 Download (USB) 

 

How to Download 

1.  For the PC with Builder running, connect with the InfoSOSA using the USB cable for 

transfer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

◆ Connect when InfoSOSA power is off. 

USB Cable 
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◆ About OSD Mode 

Mode for downloading a project via an USB cable, changing 
communication settings, changing the brightness, and so on. If 
connected to the PC when powering up, starts up in OSD mode. For 
more information, please refer to the "IS731 Series Startup Guide". 

 

2.  Turn ON the power of InfoSOSA. 

If connected to the PC when powering up, starts up in OSD mode. 

 

 

 

 

 

 

 

 

 

 

3.  From the [Download] menu, select [Download (USB)]. 

 

 

 

4.  [Select Data Dialog] is displayed. 

Select the project to download and click [OK]. 

 

 

No Item Contents 

①  Current Project For downloading the current project. Run [Create Data] and [Download] in 
consecutive order. 

②  Saved Project Data Downloads the saved project data that was created with the [Create Data] 
command. Select the download data in step 7. 
For information about [Create Data], please refer to 14.2 Create Data 
(USB/IS-APP). 

 

  

② ① 
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◆ All Data Size 

Displays after data creation. The size displayed is the size of the actual 
download data. However, since the size after downloading to InfoSOSA is 
influenced by the InfoSOSA file system (cluster size), downloading may not 
be possible due to insufficient capacity. 

 

5.  When the download project is selected in the [Current Project] field, the [Data Creation 

Dialog] is displayed. 

Click [Browse] and you can change the save destination. 

Click [Save]. 

 

 

No Item Contents 

①  Download Data Displays information on the data to create. 

②  Saving Destination Displays the save destination for created data. Click [Browse] and select 
a folder. 

③  Open data folder after 
saving 

Select the check box to open the destination folder after the create data 
operation. 

 
 
 
 
 
 
 
 
 
 
 
 
 
  

① 

② 

③ 
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◆ Download to multiple units. 

When multiple InfoSOSA are connected to the PC, they display in 
the list. For InfoSOSA you want to download to, click [Start 
Download]. 
* The maximum you can transfer at one time differs depending on 
your PC environment. When there is a transfer error, reduce the 
number of connections. The maximum is 10 units. 
* When using an USB hub, it may affect if the unit is recognized 
properly. 

 
 

6.  [Download (USB)] dialog box is displayed. 

The connected InfoSOSA is displayed. 

Click [Start]. 
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7.  [Transfer Settings] dialog box is displayed. 

Select the download data and transfer options, then click [Start Download]. 

 

 

 
 

No Item Contents 

①  Download Data Data to be downloaded will be displayed. 
Automatically set up when in step 4 you selected the [Current Project]. 
When [Saved Project Data] is selected, from the Create Data group 
select the [Compiled Project File (*.IScpi)]. 
 

②  Back Up Project onto 
unit 

Select whether to download to the unit a project file (.ipp) that you can 
edit. When there is not enough capacity on the unit, download may not 
be possible. For information on retrieving the backed up project, please 
refer to the "IS731 Series Startup Guide". 

③  Retain previous Backup 
Files 

Select whether to retain or erase the project file (.ipp) backed up to the 
unit. As you can back up only one project, the previous backup is 
deleted when backing up a new project. 

 
  

① 

② 

③ 
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Download begins. 

 

 

When the operation is complete, the following dialog box appears. 

 

 

InfoSOSA automatically restarts and the downloaded project is displayed. 

Disconnect the USB cable. 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
  

◆ While downloading, do not pull out the USB cable or turn off the 

InfoSOSA power supply. It may result in corrupted data. If data is 
corrupted, the InfoSOSA unit's data area will require formatting. For 
information about formatting, please refer to the "IS731 Series 
Startup Guide". 
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What if you cannot download? 
 
➢ If the connected InfoSOSA does not appear in the "Download 

(USB)" dialog, please uninstall all USB device drivers and 
install again. 
 

➢ In the case of Ver 2.5 download (USB) will copy data to 
InfoSOSA recognized as external storage. Downloading may 
not be possible if a security software that restricts copying to 
the USB memory is running. Please upgrade to Ver 2.6. 
 

 

◆ In order to back up the project, additional capacity is required. 

When there is not enough capacity, backup will not run. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

About Project Data Backup 

Normally, only the InfoSOSA executable files are downloaded. When the [Backup Project to 

Unit] check box is selected, in addition to the executable files, an editable project file (*.ipp) is 

backed up to the unit. For information on retrieving backup files, please refer to the "IS731 

Series Startup Guide". 

 

 

 

 

 
 
 
 
 
 
 

About Download Tool 

The download tool is included with the Builder. 

The Download Tool is for transferring download data already prepared on Builder. As this tool 

does not allow you to edit, it is most suitable for downloading in large numbers for a 

mass-produced product after the project (screen data) is complete. For more information, please 

refer to the "IS731 Series Startup Guide". 
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14.5 Download (SIO) 

 

 

 

 

 

 

 

 

 

 

 

 

How to Download 

1.  For the PC with Builder running, connect with the InfoSOSA SIO1 port using a serial cable. 

* You cannot download from the SIO2 port. 

Interface IS7 IS-APP 

SIO1 ○ - 

SIO2 - - 

 

 

 

 

 

 

 

 

 

 

  

SIO1 Serial cable 

◆In the case of Ver 2.5, download (SIO) does not update the project 

runtime application.  
 
When using InfoSOSA Builder Ver2.5, please use download (USB) 
for the initial download. 
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2.  Turn ON the power of InfoSOSA. 

 

 

 

 

 

 

 

 

 

 

3.  Open the project to download. 

 
 

4.  From the [Download] menu, select [Download (SIO)]. 

 

 
 

5.  [Download (SIO)] dialog box is displayed. 

Click [OK]. 

 

 

  

◆ When project data has not been downloaded, error screen is 

displayed. When download (SIO), please wait, switch from the error 
screen to the download screen, and then download with the following 
communication settings. 
 Communication Speed:115200bps Parity:None 
*In this case, the project runtime application is not updated. Please 
download again in the normal startup state. 
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6.  The [Communication Setting Dialog] is displayed. 

After setting the [Port], [Communication Speed], and [Parity] click [OK]. 

 

 

 

 

No Item Contents 

①  Port Set port of computer for downloading. 
Select the [COM Port] to use. 
* Only available COM ports are displayed. 
* Currently you cannot use LAN. 

②  Communication Speed If port setting is [COM port], set the communication speed. 
Select [Communication Speed] as set in InfoSOSA. (Communication 
speed set in [Communication Setting (target) Dialog]) 
* The factory default of 115200 is set. 

③  Parity If port setting is [COM port], set the communication settings. (Parity) 
Select the parity set in InfoSOSA. (Parity set in [Communication Setting 
(target) Dialog]) 
* The factory default of None is set. 

 

  

① 

② 

③ 
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7.  From the [Download (SIO/LAN)] dialog box, click [Download]. 

 

 

 

 

Data is automatically created and download begins. 
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◆ When the message "Failed to connect" is displayed. 

 
➢ Is the serial cable connected to the InfoSOSA download 

target's SIO1 port? 
  * You cannot download from the SIO2 port. 
 
➢ Is project data displayed on the InfoSOSA download target? 

* You cannot download when OSD mode is displayed. Use 
[Download (USB)]. 

 
➢ Does the communication settings for the download target's 

project data displayed on InfoSOSA match the 
communication settings defined in step 5? 

 

NOTE 

 
When complete, the following message is displayed. 

 

 

InfoSOSA automatically restarts and the downloaded project is displayed. 
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◆ While downloading, do not pull out the serial cable or turn off the 

InfoSOSA power supply. It may result in corrupted data. If data is 
corrupted, the InfoSOSA unit's data area will require formatting. For 
information about formatting, please refer to the "IS731 Series 
Startup Guide". 
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14.6 Error check 

 

Error check is a function that searches for and displays the cause of compile errors during 

"download" or "data creation", such as inadequate parameter settings. * Ver. 2.7 or later 

 

How to execute 

1.  Open the project for error checking. 

 

2.  Select [Download] - [Error check] from the menu bar. 

 

 

Error checking is performed for all resources. 

When the error checking is complete, the following message will be displayed. 

 

[No errors] 
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[With errors] 

 

 

In the above case, there is an error that the value of the parameter "Memory ID (numeric type)" 

is not selected in the action "Set Value" of the event "Press" of the part "BTN00001" of the 

screen "BAS00001”. 

 

The value of the parameter "Memory ID (numeric type)" is not selected due to the deletion of the 

global memory set in the parameter, as shown below. The error will be resolved by resetting the 

target memory. 
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If a compile error occurs during "Download" or "Create Data", the following dialog box will appear, 

and you can also run the program from here. 

 

 

 

 

 

It is also possible to perform error checking from the screen list and perform error checking only 

on the target screen. 

Click "Error check" from the right-click menu of the screen list. 
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15. Simulation 

 

 

 

Chapter Contents 

15.1  Simulator ................................................................................................. 262 

15.2  Simulator Operation ................................................................................ 265 

15.3  Simulator Settings ................................................................................... 272 
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15.1 Simulator 

 

Simulation can be performed on the computer without downloading to the InfoSOSA. 

15.1.1 Simulator Screen 

 

 

No Item Contents 

① IsSimulator View Created project screen is displayed. 
Touch operation is possible with mouse clicks. 

② SIO1 LOG Display ON/OFF of SIO1 port transmission log screen. 

③ SIO2 LOG Display ON/OFF of SIO2 port transmission log screen. 

④ LAN LOG Display ON/OFF of LAN port transmission log screen. 

⑤ SHEET KEY Turn sheet key SW screen ON/OFF. 

⑥ LED Turn sheet key LED screen ON/OFF. 

⑦ SRAM CLEAR Currently cannot be used. 

⑧ Reboot Restart simulator. 

⑨ EXIT Exit simulator. 

 
 

  

① 

⑤ 

⑨ 

⑧ 

⑦ 

⑥ 

③ 

④ 

② 
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15.1.2 Start Simulator 

1.  From the [Simulation] menu, select [Start Simulation]. 

 

The [F5] key on the keyboard also performs the same action. 

  

2.  If the project has not been saved, following dialog will be displayed. 

Click [Yes] to save the project. 

Click [OK] in the confirmation dialog box. 

 

 

 

3.  Simulator will start. 

 

 

If you get an error that "mfc140u.dll" is not found, follow the steps below to install "Microsoft 

Visual C++ 2015 Redistributable Package". 

 

 

1. Access Microsoft's download page. 

 

https://learn.microsoft.com/en-us/cpp/windows/latest-supported-vc-redist?view=msvc-170 

 

  

https://learn.microsoft.com/en-us/cpp/windows/latest-supported-vc-redist?view=msvc-170
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2. Download both "X86" and "X64" of Microsoft Visual C++ 2015 Runtime. 

 

X86 https://aka.ms/vs/17/release/vc_redist.x86.exe 

X64 https://aka.ms/vs/17/release/vc_redist.x64.exe 

 

 

3. Execute the downloaded "VC_redist.x64.exe" and "VC_redist.x86.exe" respectively to install. 

 

 

 

◆ If you are running two builders, an error will occur if you run the 

simulator in one builder while the other builder is running the 
simulator. 

https://aka.ms/vs/17/release/vc_redist.x86.exe
https://aka.ms/vs/17/release/vc_redist.x64.exe


16 Inter-Project Copy 

InfoSOSA Builder Operation Manual 265 

15.2 Simulator Operation 

 

The screen display, touch screen operation, sheet key SW, and sheet key LED can be checked 

with the simulator. 

 

15.2.1 Display 

When the simulator starts, the created screen will be displayed on the IsSimulator View. 

Screen will change as it is set to perform when operated. 

Lamp light, screen change, character display, and the numbers display can be checked. 

 

 

 

 

  

Screen Change 

Lamp Light 

Characters and Numbers Display 



16 Inter-Project Copy 

InfoSOSA Builder Operation Manual 266 

◆ The startup window size is the size of the first displayed base 

screen. 
 

 

Differences by Series 

 

In IS-APP, you can change the size of the simulator screen display window. 

 

 

 

 

* Black is displayed outside the base screen. 

 

 

 

 

 

 

 

  

Drag the mouse 
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15.2.2 Touch Screen Operation 

Touch screen operation can be done when the screen is clicked with the mouse. 

Actions set will be executed when the buttons, etc. placed are clicked. 

Actions of the buttons and the numeric keypads, etc. can be checked. 

 

 

 

You can use the mouse even for gestures that require two-point touch. 

Gesture Mouse operation 

Pinch Mouse Wheel 

Turn Right-click and drag 

 

 

15.2.3 Log Display 

"Transmission LOG" is displayed when you click each port's [Display Log] button. 

You can confirm the communication message by connecting the PC and the microcontroller. 

 

* Each port in the [Simulation Settings] must be enabled. 

Check action by clicking button 
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No Item Contents 

① Display Set display method of Send and Recv log. 

② Send log Display transmitted message from simulator. 

③  Recv log Display received message from host. 

④  Save File Set save format. 
* When saved with the BINARY check box selected 
Saves as .bin file. 

⑤  Save Save in set format of save file. 

 
  

 

 

① 

③ 
 

⑤ 
 ④ 

② 
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15.2.4 Sheet Key SW 

When the [Sheet Key SW] is clicked, [Sheet Key View] is displayed. 

The operation of Sheet Key SW can be checked. 

Action set to the number of the sheet key will be executed by clicking with the mouse. 

Click [Sheet Key SW] again and the [Sheet Key VIew] closes. 

 

* Sheet key SW is disabled by default. 
To use, it must be enabled in [Simulation Settings]. 

 
  

Check action by 
clicking the number 
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15.2.5 Sheet Key LED 

When [LED] is clicked, [LED Screen] is displayed. 

The operation of sheet key LED can be checked. LED will turn ON/OFF to match the setting. 

When [LED] is clicked again, [LED Screen] closes. 

 

* Sheet key SW is disabled by default. 
To use, it must be enabled in [Simulation Settings]. 

  

LED ON 
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15.2.6 Reboot 

Click [Restart] and "IsSimulator Display View" is restarted. 

It is used to redo the operation check from the initial state. 

 

 

15.2.7 End of Simulator 

The Simulator ends when you click [Exit]. 
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15.3 Simulator Settings 

 

15.3.1 Setting Procedure 

1.  From the [Simulation] menu, select [Simulation Setting]. 

 

 

2.  The following dialog will be displayed. 

Select check boxes of necessary items and click [Save]. 

 

 

No Item Contents 

①  Touch Panel When the check box is selected, you can use the simulator (with 
mouse) to check touch screen operations. 

②  LAN When the check box is selected, you can run host 
communication from the PC LAN port. LAN device can be 
selected. It can be used to perform communication simulation 
between host device and computer. 

③  SIO1 When the check box is selected, you can run host 
communication from the PC serial port (SIO1). Select COM port 
to be used. It can be used to perform communication simulation 
between host device and computer. 

④  SIO2 When the check box is selected, you can run host 
communication from the PC serial port (SIO2). Select COM port 
to be used. It can be used to perform communication simulation 
between host device and computer. 
* Even if the device is RS422/485, in simulation it operates as 
RS232. 

⑤  Buzzer When the check box is selected, the InfoSOSA buzzer sounds 
are emitted from the speakers on the PC. 

⑥  Sheet Key If the check box is selected, [Display Sheet Key] button is 
enabled. 

⑦ ⑥ 

⑧ ④ ③ 

⑤ 

① 

② 
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No Item Contents 

⑦  LED If the check box is selected, [Display Lamp] button is enabled. 

⑧  Storage Configuration Currently cannot be used. 
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16. Inter-Project Copy 

 

 

 

Chapter Contents 

16.1  About Inter-Project Copy ......................................................................... 275 

16.2  Copyable resources ................................................................................ 276 
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16.1 About Inter-Project Copy 

 

Inter-Project Copy is a function that allows you to start two InfoSOSA builders, open a different 

project in each builder, and copy resources between the two projects. 

*Version 2.7 or later 

 

 

 

      
 

 

 

 

 

 

 
 

 

 

 

 

 

 

◆ Be sure to use the same version of the builder for the source 

and the destination builder. Copying to different versions will 
not work properly. 
 

◆ Related resources (memory, images, etc.) set in parts and 

actions need to be copied separately. To prevent copy 
omissions, be sure to perform an error check after copying. 
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16.2 Copyable resources 

 

 

16.2.1 Screen 

Copies the specified screen. Parts, screen memory, and action settings in the target screen are 
also included. 

 

Method 1: Copy and paste 

1.  Right-click the screen to be copied in the screen list of the builder from which you want to 

copy, and click "Copy". 

 

. 

 

2.  Right-click on the screen list of the builder you want to copy to and click "Paste". 

 

 

 

The screen will be copied to the destination builder by the above operation. 
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Method 2: drag and drop 

1.  Drag (left-click and hold) the screen to be copied in the screen list of the source builder, and 

drop it in the screen list of the destination builder. (Release the left click) 

 

 

 

 

 

The screen will be copied to the destination builder by the above operation. 
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Notes. 

 

◆ If a screen with the same ID as that of the screen to be copied already exists in the 
destination project, the copied screen will be changed according to the ID assignment rules 
at the time of new creation. 

 

◆ If the action set in the screen to be copied refers to global data such as global memory or 
string resources, it will be necessary to copy or create the global memory separately. 

 

◆ If the same ID as the target global memory, etc. already exists in the destination project, 
that memory will be the target. Please be careful. 

 

◆ When copying a screen to a project with a different screen size, adjust the screen size to 
that of the destination before copying, and change the "Representative Type" or "Default 
Screen Size" from the H/W Settings dialog to make a batch change. 

 

 

 

 

 

16.2.2 Parts, Groups Parts 

Copies the specified part or group of parts. The action settings in the target part are also 
included. 

 

Method 1: Copy and paste 

1.  Right-click on the part or group of parts in the builder you want to copy from, and click Copy. 

 

You can also use [Edit] - [Copy] on the menu bar, [Ctrl] + [C] on the keyboard, or [Copy] on the 
toolbar. 

 

 

  

◆ Be sure to perform an “Error check” after copying. 
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2.  Right-click on the builder you want to copy and click "Paste". 

 

You can also use [Edit] - [Paste] on the menu bar, [Ctrl] + [V] on the keyboard, or [Paste] on the 
toolbar. 

 

 

 

The above operation will copy the part to the destination project. 

 

 

Notes. 

 

◆ If a part with the same ID as the ID of the part to be copied already exists in the destination 
project, the copied part will be changed according to the ID assignment rules at the time of 
new creation. 

 

◆ If the action set in the part to be copied refers to global data such as global memory or string 
resources, it will be necessary to copy or create the global memory separately. 

 

◆ If the same ID as the target global memory, etc. already exists in the destination project, 
that memory will be the target. Please be careful. 

  

◆ Be sure to perform an “Error check” after copying. 
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16.2.3 Action 

Copies the specified action. 

 

Method 1: Copy and paste 

1.  Select the action of the builder you want to copy from, and click "Copy". It is possible to copy 

by block. 

 

 

 

If you select [A], the range in the red frame (all) will be targeted. 

 

 

  

[A] 
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If you select [B], the range in the blue frame (IF Block) will be targeted. 

 

 

If you select [C], only that action will be targeted. 

 

 

 

2.  Open the Action Settings dialog of the builder you want to copy to. 

 

 

 

 

 

  

[B] 

[C] 

◆ From Ver. 2.7, it is now possible to paste a copied action to 

another part. 
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3.  Select the paste location and click "Paste" or "Paste to Block" in the Action Settings dialog 
for the destination. 

 

 

 

If you click on "Paste," it will be added below the selected line. 

 

If you click on "Paste to Block", it will be added below the last line in the selected block. 

 

 

Notes. 

 

◆ Resources referenced by parameters in the action to be copied (such as screen, global 
memory or string resources) will need to be copied or created separately. 

 

◆ If the same ID as the target global memory, etc. already exists in the destination project, 
that memory will be the target. Please be careful. 

 

◆ If you copy the IF block, etc., please also copy the ELSE block, etc., which is the 
counterpart. If there are any missing blocks, a compile error will occur. 

  

◆ Be sure to perform an “Error check” after copying. 
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16.2.4 Subroutine 

Copies the specified subroutine. The action settings in the target subroutine will also be 
included. 

 

Method 1: Copy and paste 

1.  Select the subroutine of the builder you want to copy from and click "Copy"; you can select 

multiple subroutines by holding down the Shift key (or Ctrl key). 

 

 

 

 

2.  Click "Paste" on the subroutine of the builder you want to copy. 
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Notes. 

 

◆ If memory with the same ID as the ID of the subroutine to be copied already exists in the 
destination project, the copied subroutine will be modified according to the ID assignment 
rules at the time of new creation. 

 

◆ If the action set in the subroutine to be copied refers to global data such as global memory 
or string resources, it will be necessary to copy or create that global memory or other data 
separately. 

 

◆ If the same ID as the target global memory, etc. already exists in the destination project, 
that memory will be the target. Please be careful. 

 

 

 

 

 

16.2.5 Screen Memory, Global Memory 

Copies the specified screen memory and global memory. The action settings in the target 
memory are also included. 

 

Method 1: Copy and paste 

1.  Select the screen memory and global memory of the builder you want to copy from, and click 

"Copy". 

 

 

 

  

◆ Be sure to perform an “Error check” after copying. 
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2.  Click "Paste" on the screen memory and global memory of the builder to be copied. 

 

 

 

 

The above operation will copy the memory to the destination project. 

 

Notes. 

 

◆ If a memory with the same ID as that of the memory to be copied already exists in the 
destination project, the copied memory will be changed according to the ID assignment 
rules at the time of new creation. 

 

◆ If the action set in the memory to be copied refers to global data such as global memory or 
string resources, it will be necessary to copy or create the global memory separately. 

 

◆ If the same ID as the target global memory, etc. already exists in the destination project, 
that memory will be the target. Please be careful. 

 

 

  

◆ Be sure to perform an “Error check” after copying. 
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16.2.6 Global Memory Group 

Copies the specified global memory group. 

 

Method 1: Copy and paste 

1.  Select the global memory group of the builder you want to copy from, and click "Copy". 

 

 

 

 

2.  Click "Paste" in the global memory group of the builder you want to copy to. 

 

 

 

The above operation will copy the global memory group to the destination project. 
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Notes. 

 

◆ If a global memory group with the same ID as the ID of the global memory group to be 
copied already exists in the destination project, the copied global memory group will be 
changed according to the ID assignment rules at the time of new creation. 

 

◆ If the global memory in the global memory group does not exist in the destination project, 
the target global memory will be excluded from the global memory group. Please copy the 
global memory to which it belongs before copying the global memory group. 

 

◆ If the same ID as the global memory in the global memory group already exists in the 
destination project, that global memory will be the target. Please note this. 

 

 

16.2.7 String Resources 

Copies the specified string resource. 

Before copying a string resource, you need to align the number of string resource sets. 

 

Method 1: Copy and paste 

1.  Make sure that the string resource set of the source project is aligned with the string 

resource set of the destination project. 

 

 

 

 

 

 

make uniform 
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2.  S elect the string resource tab of the builder you want to copy from, and click "Copy"; you 
can select more than one by holding down the Shift (or Ctrl) key. 

 

 

 

 

3.  Click "Paste" on the String Resource tab of the builder you want to copy to. 
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4.  If the destination project has a string resource with the same ID, you can choose to overwrite 
it or add it as a new ID. 

 

 

 

The above operation will copy the string resource to the destination project. 

 

 

Notes. 

 

◆ If the number of string resource sets of the source and the destination are the same, it is 
possible to copy them. Note that even if the order, etc., is different, they will be copied as is. 
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16.2.8 Image Resources 

Copies the specified image resource. 

 

Method 1: Copy and paste 

1.  Select the image resource of the builder you want to copy from and click "Copy"; multiple 

selections are possible by holding down the Shift (or Ctrl) key. 

 

 

 

 

2.  Click "Paste" on the image resource of the builder you want to copy to.  

 

 

 

 

This will copy the image resource to the destination project. 
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Method 2: drag and drop 

1.  Drag (left click and hold) the image resource of the source builder and drop it on the screen 

list of the destination builder. (Release the left click) 

 

 

 

 

 

 

 

 

This will copy the image resource to the destination project. 
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Notes. 

 

◆ If an image resource with the same ID as that of the image resource to be copied already 
exists in the destination project, the copied image resource will be modified according to the 
ID assignment rules for new creation. 

 

◆ If an image resource with the same file name is registered in the destination project, it will 
be overwritten. 
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16.2.9 Sound Resources 

Copies the specified sound resource. 

 

Method 1: Copy and paste 

1.  Select the sound resource in the builder you want to copy from and click "Copy"; multiple 

selections are possible by holding down the Shift (or Ctrl) key. 

 

 

 

 

2.  Click "Paste" on the sound resource of the builder you want to copy to. 

 

 

 

The above will copy the sound resources to the destination project. 
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Method 2: drag and drop 

1.  Drag (left-click and hold) the sound resource from the source builder and drop it in the 

screen list of the destination builder. (Release the left click) 

 

 

 

 

 

 

The above will copy the sound resources to the destination project. 
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Notes. 

 

◆ If a sound resource with the same ID as the ID of the sound resource to be copied already 
exists in the destination project, the copied sound resource will be modified according to the 
ID assignment rules when creating a new one. 

 

◆ If a sound resource with the same file name is registered in the destination project, an error 
will occur. (The file will not be copied.) 
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17. Appendix 
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17.1 Corresponding Model List 
Below is a correspondence table of the model name and product type. 

 
 

17.1.1 IS7 Series 

 
 
 
 
 
 
 
 
 
 

 

17.1.2 IS-APP 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

*1 In IS-APP, multilingual setting is possible because project data is common to all models. 

 During operation, refer to the license information of the main unit and judge whether it is 

possible to execute the project data. 

 

 

Product Model Model Type 
No. Of 
Colors 

Multilingual Model Name 

IS731-3Q-D05 IS731-3Q 65536  IS731-3Q 

IS731-4WQ-D05 IS731-4WQ 65536  IS731-4WQ 

IS731-4WQ1-D05 

IS731-4WQ2-D05 

IS731-5V-D05 IS731-5V 65536  IS731-5V 

Product Model Model Type 
No. Of 
Colors 

Multilingual Model Name 

EMG8-W104A7-0005-207 IS-APP-A7 - *1 EM8-W104A7 

EM8-W104A7-0005-207 - *1 

EMG8-205A7-0005-207 - *1 EM8-205A7 

EM8-205A7-0005-207 - *1 

EMG8-W207A7-0005-207 - *1 EM8-W207A7 

EM8-W207A7-0005-207 - *1 

EMG7-W207A8-0024-107-01 IS-APP-A8 - ○ EMG7-W207A8 

EMG7-312A8-00DC-107-01 - ○ EMG7-312A8 
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18. Other 
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18.1 Inquiries 
If you have any questions, feel free to contact us. 

 
 
 
 

By E-mail 

 

North South America area 

 technical-global@dush.co.jp 

 
Asia Pacific area 

 technical-global-asia@dush.co.jp 

 
Europe, Middle East, Africa area 

 technical-global-eu@dush.co.jp 

 
 

FAQ 

www.dush.co.jp/english/support/faq/ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Microsoft®, Windows®, Windows® 10, Windows® 11, and Microsoft® .NET Framework are registered trademarks of 
Microsoft Corporation in the United States and other countries. Other company and/or product names listed herein are 
also trademarks and/or registered trademarks. 

 
13th Edition   December 2024 

DMC Co., Ltd. 
Office hours: 9:00 - 17:00 weekdays 

(except Saturdays, Sundays, national holidays, and year-end and New Year holidays) 
https://www.dush.co.jp/english/ 
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